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INTRODUCTION TO THE MANUAL

BACKGROUND AND PURPOSE OF THE MANUAL

Uganda, like many countries, faces gender inequities that impede the full realization of
human rights and development potential for all its citizens. While the country has made
advancements in achievement of gender equality and empowerment of women and
girls, gaps remain in economic participation and opportunity, and political empowerment
contributing to an overall decline on the global gender gap index from 0.717 in 2020 to
0.706 in 2024." Gender disparities persist in various spheres of life, including education,
health, employment, and political participation. Recognizing the importance of addressing
these disparities, therefore Uganda is party to numerous international and regional
agreements. At the global level, Uganda is party to the Convention on Elimination of All
Forms of Discrimination Against Women (CEDAW) 1979; Sustainable Development Goals,
The Beijing Declaration and Platform for Action (1995); The Commonwealth Plan for Action
on Gender and Development. In addition, Uganda has domesticated UN Security Council
Resolutions 1325 and 1820 which guide States and non-state actors to address Sexual and
Gender Based Violence against women in armed conflict. The Government of Uganda has
also enacted several Laws to promote children and women’s human rights at the national
level and adopted the National Gender Policy in 2007 to guide all Government policies and
programmes across sectors and at all levels to contribute to the elimination of existing
gender inequalities. The demand for gender statistics has since increased over the years
owing to these frameworks and gender mainstreaming in policies for enforcement and
budget allocation for their implementation.

Gender statistics play a crucial role in identifying disparities, monitoring progress, and
designing targeted interventions to address the specific needs of different gender groups.
This closely follows the Beijing Platform for Action paragraph 206 (a) which recommends
national, regional and international statistical services ensure that statistics related to
individuals are collected, compiled, analyzed and presented by sex and age and reflect
problems, issues and questions related to women and men in society. Uganda has made
notable strides in producing sustainable development indicators at the national level, with
a focus on disaggregation and the inclusion of Gender Equality and Women Empowerment
(GEWE) issues. The country has significantly increased the number of gender-specific SDG
indicators with available data, from 11 out of 54 in 2018, to 24 in 2020, and 32 in 2023.2
However, despite these advancements, there remains substantial gaps in the uptake and
utilization of available statistics for programming and reporting. These include the limited
capacity for gender-sensitive data analysis, presentation, and interpretation and a lack
of awareness about the importance of and available sources of gender statistics hinder
efforts to address gender inequalities effectively.

It is for this reason that the EPRC collaborated with UN Women, Uganda Bureau of
Statistics (UBOS), and the Ministry of Gender, Labour, and Social Development (MGLSD)
to develop this facilitator manual on the production and use of gender statistics. This

1 Global Gender Gap Report, 2020 and 2024
2 https://africa.unwomen.org/en/digital-library/publications/2024/07/ugandas-3rd-voluntary-national-review-report-on-the-im-
plementation-of-the-2030-agenda-for-sustainable-development
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facilitator manual aims to address these challenges by providing trainers or facilitators
with the necessary tools, resources, and methodologies to enhance the capacity of users
to analyse, present, interpret and utilize gender statistics effectively. At the completion
of training using this manual, participants are expected to have achieved the following
learning outcomes:

1. Understoodthe key concepts and definitions related to gender and gender statistics,
including sex, gender, data, information, gender statistics, gender equality, women
empowerment, gender gap, and gender-responsive indicators.

2. Understood the process of undertaking an information needs assessment

3. Understood the importance of gender statistics in informing policies and
programmes aimed at achieving gender equality and women’s empowerment in
Uganda.

4. Developed skills in sourcing, analysing, interpreting, and presenting gender-
responsive data, using appropriate statistical methods and techniques.

5. Gained proficiency in data visualisation for effective communication of gender
statistics.

TRAINEES TARGETED BY THE MANUAL

The training on gender statistics primarily targets middle level officers in government
institutions who provide information input to policy and other decisionmakers. These
officers usually support the research, planning, monitoring and evaluation, reporting,
and communication functions of their institutions. The officers may include planners
(including senior and principal planners), economists (including senior and principal
economists), statisticians (including senior and principal statisticians), gender desk
officers, policy analysts, and communication personnel. Many of these officers, excluding
the communication personnel, are qualified in statistics or economics. They have basic to
advanced statistical competencies, without adequate knowledge of gender concepts and
methodologies. This training resource would help them to integrate a gender perspective
in the statistics cycle. The secondary audiences of this manual are other influencers in
the policy and other decision-making processes of government, including middle level and
senior officers in research institutions, academic institutions, think-tanks, consulting firms,
CSOs, media institutions, and international organisations. The secondary audiences are
quite diverse, with some qualified in statistics or economics and others grounded in law,
social sciences, or related fields. This training resource would help the policy influencers
without statistics knowledge to understand how to apply their gender knowledge in the
statistics process. Therefore, the trainees or participants will be from:

e Government authorities spearheading national and decentralized planning i.e. the
National Planning Authority (NPA), Ministry of Finance, Planning and Economic
Development (MOFPED), and Planning Units in Local Governments (LGSs).

e Government authorities promoting equal opportunities e.g. Ministry of Gender,
Labour, and Social Development (MGLSD) and the Equal Opportunities Commission
(EOC).

e Government authorities responsible for monitoring, evaluation and reporting on
the implementation of government programmes and international commitments
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such as the SDGs.

e Other government authorities that offer services addressing gender equality
directly and indirectly e.g. ministries of health, education, agriculture, justice, and
local governments.

e Civil society organisations, including women'’s and/or feminist organizations.

e Research and academic institutions, including universities, think-tanks, research
institutes, and consulting firms, with interest in equality, equal opportunities,
feminism, and other gender-related topics.

e Public libraries, information centres, and media institutions.

e International organisations, including United Nations agencies.

THE PROCESS UNDERTAKEN TO DEVELOP THIS MANUAL

A participatory approach was used in the development of this Manual. The process was
spearheaded by EPRC and supported by UBOS, UN women and MGLSD. It begun with
a needs assessment and stakeholder consultation to identify the specific gaps and
challenges related to gender statistics in Uganda. This involved 17 government agencies
and CSOs, who were involved in individual interviews and a focus group discussion.

Building on the findings of the needs assessment, EPRC conducted a thorough review
of existing manuals, research, and best practices in gender statistics and adult learning
methodologies. This review helped to identify relevant resources, frameworks, and
tools that informed the structure and content of the facilitator manual. Localization and
contextualization of the manual was done to ensure that it is tailored to the specific needs
and context of Uganda. This involved incorporating country-specific data, case studies,
examples, and policy frameworks into the manual.

The draft manual was reviewed in a workshop of selected EPRC staff, and pilot tested in a
training workshop with a diverse group of participants, including statisticians, economists,
monitoring and evaluation experts and gender experts from NPA, MOFPED,CSBAG,0PM,
CEDOVIP,PSFU, MOGLSD, UBOS and UNWomen. During the pilot workshop, participants
had the opportunity to engage with the manual, provide feedback on its content and
usability, and suggest revisions or improvements. The EPRC carefully documented the
feedback and incorporated it into the final version of the manual.

This manual is available in physical and electronic copy to be used in in-person -instructor
led training. The manual has been printed for wide dissemination through workshops,
conferences, and online platforms, making it accessible to abroad audience of stakeholders
in Uganda and beyond. EPRC will provide ongoing support and mentorship to facilitators,
monitor the implementation of training activities, and collect feedback for continuous
improvement of the manual.

STRUCTURE, SCOPE, AND HOW TO USE THE MANUAL

The facilitator manual is structured into five modules. A module is a main topic on gender
statistics. This manual begins with an introduction and background section, providing an
overview of the key concepts and the importance of gender statistics in Uganda. Following

vi EMBEDDING GENDER STATISTICS IN DECISION-MAKING
A Facilitator Guide for Training of Users of Gender Statistics in Uganda



this, the manual is divided into modules relating to the statistical processes of sourcing
gender statistics, data analysis and interpretation, and data presentation. Each module is
divided into sessions, with relevant subtopics. Each session contains:

e Learning objectives—describes what participants will know or can do by the end
of the session. This relates to increased knowledge, improved skills, or changed
attitudes. The facilitator should present the objectives at the beginning of each
session. S/he can write the session objectives on a flipchart.

e Methods—are the ways (strategies and approaches) a facilitator uses to transfer
knowledge, skills, or influence participants’ attitudes (See training duration and
methods).

e Duration—indicates the approximate length of a session. The allocated time for
each session is only a guide to a facilitator. Each facilitator should determine the
appropriate duration for a session, or activity based on the trainees’ knowledge
level, number of trainees and the selected training methods.

¢ Requirements—lists the items and conditions for the session, considering the
needs of facilitators and participants. Other inherent venue requirements such as
electricity are excluded from this list.

e Preparation—lists tasks the facilitator must do before the session.

e Activities/ exercises— are the specific tasks that participants engage in during the
training session to acquire knowledge, skills, or changed attitudes.

¢ Notes/ Handouts—provides content to guide the facilitator but should also be
reproduced for all participants. Handouts can be provided at the end of each
training day.

The manual also includes appendices with additional resources and references for further
exploration. The manual covers abroad range of topics related to gender statistics, catering
for both beginners and more advanced users. It addresses the specific challenges and
needs of users in Uganda. It covers both micro and macro data, and official and non-official
statistics. It aims to create “gender statistics literacy”, but not to produce statisticians
or gender experts. By gender statistics literacy, we mean the ability to understand,
interpret, analyse, and use gender-related statistics effectively. It involves having the
knowledge and skills to navigate gender-disaggregated statistics, recognise gender
biases and inequalities within datasets, and leverage gender statistics to inform policies,
programmes, and decision-making processes. The manual does not cover learning how to
perform statistical data analysis and visualization of micro datasets using packages such
as STATA, SPSS, R, etc. The manual emphasizes practical application, providing hands-on
exercises and real-life examples tailored to the Ugandan context.

HOW TO USE THE MANUAL:

To make the best use of the manual, the facilitators need to first acquaint themselves with
its content and style. The Manual content is broad enough and can be adapted for various
categories of trainees based on the results of the pre-training needs assessment and
participants’ expectations. A sample of a pre-training needs assessment tool is provided
in Appendix 1. For gender equality practitioners without adequate statistical knowledge,
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the facilitator can deepen the content on data cycle. Statisticians without adequate gender
knowledge would need a deeper focus on gender concepts and terminologies and the
importance of gender mainstreaming in the statistics cycle. Practitioners with adequate
knowledge of both gender and statistics would not be the target for this training, but they
can participate in experience sharing or short refresher sessions.

It is important to arrange separate training events for government officers with a
background in economics and statistics and other trainees without a statistics or
economics background. Both their competencies and uses of gender statistics differ. The
training should last at most 6 days (for beginners) and three days for users who require
skills upgrade. The planned schedule includes a four-day training workshop, with each
day comprising eight hours of activities, including breaks for lunch and tea. Overall, the
facilitators should keep the content as simple and context specific as possible. Where
necessary, the facilitator(s)should further simplify the content to suit the target group.

It is also important for the facilitators to undertake further reading on the training topics
as the information provided in this Manual is not exhaustive. The starting point is the list
of resource materials provided in the Appendices of this Manual. Both facilitators and
participants can provide feedback on the manual’s content, structure, and usability to
EPRC to help improve future versions.

PROPOSED TRAINING METHODS

Method What it means and involves
Plenary Plenary brainstorming is a collaborative method where all members
brainstorming of a group come together to generate ideas, solve problems, or

discuss topics, rather than in smaller subgroups. The term “plenary”
indicates that the session includes all participants, ensuring that
everyone can contribute and hear each other’'s thoughts. Plenary
brainstorming should be particularly used at the start of sessions.
During brainstorming sessions, participants should be encouraged
to share their opinions freely without criticizing what others have
shared. At the end of each activity, the debriefing discussions will
identify common perceptions and conflicting opinions. Facilitators
can utilize VIPP cards to encourage active participation from

everyone.
Plenary Verbal exchange of ideas between facilitators and participants —
discussion usually undertaken as a brainstorm or after working on a common

assignment in groups. To gain maximum results, the plenary should
be limited to one topic addressing pre-defined issues/ questions.
The feedback session should be facilitated by a moderator
knowledgeable about the issue under discussion.

viii EMBEDDING GENDER STATISTICS IN DECISION-MAKING
A Facilitator Guide for Training of Users of Gender Statistics in Uganda



Method

Work in pairs and
work in groups

Case study

Presentation

Video screening

Exercise/
assignment

Demonstration

What it means and involves

Participants discuss in pairs or groups. Working in pairs can be used
in instances where there is insufficient time for group work, but you
want to generate discussion among participants or prefer to break
up the discussion into subtopics. Group work is ideal in discussing
complex issues that require diverse perspectives. Encourage
participants to respect other people’s opinions as participants are
more likely to share their feelings and ideas if they know they will
not be judged or criticized for what they share

The group is presented with information on a real or realistic
situation either through a presentation or documented piece of work.
The participants discuss and analyse issues relevant to the topic
of interest. The use of case studies is one of the primary methods
employed to train adults. It is anticipated that case studies will
create interest and motivate participants because they are realistic,
relevant, and present challenging situations.

Involves an expert or experienced trainer guiding participants
through key concepts, methodologies, and applications related to
gender statistics. This method combines direct instruction with
interactive elements to enhance learning and engagement. This is
suitable in technical areas such as categories of gender responsive
indicators.

Involves using video content to educate and train individuals on
the analysis, interpretation, and application of gender-related data.
This method leverages the power of visual and auditory learning to
make complex statistical concepts more accessible and engaging.
For example, videos featuring interviews with statisticians,
policymakers, and beneficiaries who discuss the importance and
impact of gender statistics.

Specific tasks are essential to help participants apply theoretical
knowledge to practical situations. For example, analysis of gender
statistics in the Police Annual Crime and Road Safety Report.

Involves showing participants how to perform specific tasks, use
tools, or apply techniques related to the analysis, and interpretation
of gender-related data. This method is highly effective for teaching
practical skills and ensuring that participants can see the exact
steps involved in various processes. For example, how to compute
the measures of central tendency such as mean and median or
statistical measures such as proportion and percentage.
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TIPS FOR PLANNING A TRAINING EVENT.

A facilitator should directly or through the training organisers utilise the following tips:

Participants: Training organisers should map officers in the priority sectors targeted at
increased use of gender statistics based on their roles. They should encourage agencies
to consider both women and men when nominating participants. The facilitators should
send the training programme to participants at least a week in advance to enable them
to know the content to be covered and any pre-training preparation (such as advance
reading) they need to make.

Training requirements: The requirements, including training materials, are listed in the
outline for each session and these are guided by the proposed training methods. These
suggestions are not exhaustive and so the facilitators should use other context and
culturally appropriate training methods and materials within their reach. Facilitators can
prepare PowerPoint Slides using the ‘Notes’ and can print the Notes as handouts for
participants. Some exercises and training evaluations can be administered online.

Venue: The venue should be checked and set up a day before the training. All equipment
should be tested. There are different ways of setting up the training room, depending on
the intended learning environment and the nature of the participants. Consider fresh air;
light; ease of movement; sight lines from different angles; and the display of materials
while planning the venue set-up.

Co-facilitation: Facilitators of this course should possess training experience, strong
statistical expertise, and either work experience or training specifically in gender statistics.
A co-facilitator is recommended in delivering this training, due to its content, length, and
facilitation style (a combination of experiential learning and participatory approaches).
One facilitator may not necessarily have the mastery of all the Modules and alteration
of facilitators exposes participants to new facilitation experiences. A combination of a
statistician and a gender expert would be ideal to facilitate this training. It is good practice
for facilitators to meet before - hand to plan sessions, divide sessions or topics and to
have joint reflection at the end of each training day.

Introducing the Training: The Modules have been organised in chronological order. It is
therefore recommended that the training follows the line-up of the Modules and Sessions.
In instances where the target trainees do not need much detail on a given module or
session, the facilitator should provide an overview. The start of the training should have
an introduction or welcome remarks from the facilitator, an icebreaker, and participant
introductions, setting ground rules and any other relevant issues, based on the context.
This should beimmediately followed by an overview of training objectives and programme/
agenda. The specific guidance on starting a training workshop includes:

Participants’ introduction: Introductions should take between 15 and 20 minutes. The
facilitator should allow a representative of the convening organisation to welcome the
participants, make a few remarks to open the workshop and introduce the facilitator. The
meeting convener should provide relevantinformation about arrangements for participants’
meals, transport, accommodation, and allowances. After being introduced, the facilitator
should greet the participants and re-introduce themselves and any other workshop staff.
The facilitator should conduct an introductory activity so that all participants are aware
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of themselves and the organisers. The participants should be requested to mention their
names, workplace, and any other relevant information. Below are two proposed exercises
for participants’ introduction:

Exercise A: My name is...and | like...

Steps
i. Ask the participants to sit or stand in a circle.
ii. Divide the participants into groups of about five.

iii. Request the first participant to mention their name and the name of a favourite
animal, fruit, colour, game, place, etcetera, that begins with the same letter as
their first (most often religious) name. For example, “My name is Simon, and | like
School” Ask the next participant to repeat this and to add their own name. For
example, ‘His name is Simon, and he likes School. My name is Jane, and | like
Javelin!

iv. Continue until all participants have introduced themselves in this way.

Remember...

e Participants should not feel embarrassed if they cannot remember the whole
sequence. Instead, encourage the group members to help each other out by giving
clues.

e If the participants cannot think of an animal, fruit, colour, game, or place that
begins with the same letter as their name, do not let them feel embarrassed.
Instead, encourage the group members to help. You may also suggest adjectives
that describe the participant for example ‘My name is Henry, and | am Happy!

Exercise B: If | could be...

Steps

I. Ask the participants to stand or sit in a circle.

il. Request them the participants to think about who they would like to be and why.
You can suggest categories of famous people from history, politics, sports, music,
movies, or respected personalities they know in their local community.

iii. Ask each participant to introduce themselves and say who they would like to be
and why.

Remember...

This works best when done fast.

Seeking participants’ expectations (10 — 15 minutes):

I. Ask the participants to take two minutes to think of the expectations they have
for the workshop. Clarify that this should be something they want to learn about
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gender statistics to avoid preoccupation with expressions about allowances, etc.
ii. Inan anticlockwise direction, ask each participant to mention their expectations.

iii. Write the expectations on a Flip Chart paper and keep them on the wall for everyone
to refer to during the training.

iv. Explain whether this training will address each of the expectations shared by the
participants. If it will not, explain why and how interested participants can gain
such knowledge.

Presentation of the workshop objectives (5 — 10 minutes): The Facilitator can either
write out the objectives on a flip chart or print it out and give each participant a copy.
Immediately following the expectations, the facilitator should read out the objectives of the
workshop and check them against the expectations. Ensure that participants understand
the workshop objectives or intended outcomes. Allow participants to raise any questions
or concerns they may have about the objectives of the training event.

Setting ground rules/ workshop etiquette (5 — 10 minutes): Ask the participants to propose
a list of rules that will guide the training sessions. These could include:

= Give everyone a chance to speak and participate.

*= Put mobile phones on vibration or silent mode etc.

= Respect time—start on time, end on time.

*= Be respectful to each other and the facilitators.

=  When contributing, talk loud enough for everyone to hear.
*= Let one person speak at a time.

= No side talks, etc.

Discuss and agree on the rules/ etiquette that will guide the training sessions.
Write these on another flip chart.

Ask participants if they agree to abide by these ground rules.

< BY <

Post the ground rules list on the wall in the training room.

TRAINING EVALUATION AND REPORT

It is important that you plan how the training will be evaluated to gauge if the objectives
have been achieved. Besides the general training evaluation, session specific assessment
should be done before moving to the next session. Similarly, the structure of the training
report should be developed in advance and important notes written down daily to ease the
preparation of a report at the end of the training. Samples of evaluation form and report
format are provided in Appendices Il and Il of this Manual.
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MODULE ONE: INTRODUCTION TO GENDER
AND GENDER STATISTICS

/ Learning Outcomes/Objectives
O By the end of this module, participants are expected to have:

a. Become familiarwith the key concepts in gender and gender statistics.

b. Appreciated the importance of gender statistics in advancing gender
equality and women’s empowerment.

c. Understood the foundation for integrating a gender perspective in
statistics.

Overview of the Module
N The modules cover definition of key gender and statistics concepts, examine

gender statistics and its importance in achieving GEWE, examines how to
integrate a gender perspective in statistics and the data value chain.

— 4P Note to Facilitator

-— b

- | Understanding the distinction between sex and gender is crucial for
statistical analysis and policy development. In gender-focused research,
data must be disaggregated by sex to analyze gender-related disparities
effectively. However, sex-disaggregated data alone is not always sufficient;
understanding broader gender dynamics provides a deeper context for
gender-sensitive policymaking. Gender is not just about women; it also
includes men, boys and girls, as their societal positioning influences gender
relations and equity.

Gender equality and equity are distinct but interconnected concepts.
The reality often highlights systemic inequalities where some groups
have more advantages than others. Statistical analysis in gender studies
involves assessing gender balance, gender parity, and gender norms, and
understanding the roles of data users and producers. Therefore, there is
need to emphasize how gender-sensitive data collection and analysis are
essential for informed policy decisions, equitable resource allocation, and
addressing systemic inequalities

L TIME:
..' 5 Hours 10 Minutes
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SESSION 1.71: DEFINITION OF GENDER AND STATISTICS CONCEPTS

Session objective: Enable participants to become familiar with key concepts in gender
and statistics

Methods: Plenary brainstorming, a facilitator’s presentation, video screening, and
quizzes
Requirements: A projector, a computer, internet access for the facilitator &

participants, an audio device, flipchart papers, and marker pens

Preparation: Before the session, the facilitator should produce printouts of Exercises
1.1.B, 1.1.C, and 1.1.E or design them as online quizzes.
Identify a suitable video on gender equality when planning the training

event.
Duration 200 minutes
Activity 1.1A: Differentiating sex and gender

1.1B: Gender Equality Versus Equity
1.1C: Data, information, and statistics

.1A: Sex versus Gender

.1B: Gender Equality Versus Gender Equity
.1C: Concepts in Gender Statistics

.1D: Data, Information, and Statistics

Notes/Handouts

— — — —

Exercises 1.1Aa: Sex vs Gender
1.1Ab: Sex vs Gender
1.1B: Gender Equality vs Gender Equity

Answers to 1.1Aa: Sex vs Gender
exercises 1.1Ab: Sex vs Gender
1.1B: Gender Quality Vs Equity

i. Ask 3 to 5 participants to explain their understanding of the concepts of sex and
gender. Prompt them to provide definitions and examples.

ii. Note participants’ responses on a flipchart.

iii. Then use Notes 1.1Aa to summarise key differences, emphasising the main points
and clarifying misconceptions. The main points are:
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v" Sex and gender are often confused, but do not mean the same thing.

v' Sex refers to the biological and physiological difference between men and
women and the biological characteristics that define humans as female or
male. These differences do not change.

v' Genderrefers to socially constructed roles, behaviours, activities, and attributes
that a given society considers appropriate for men and women. Gender is
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learned and changes over time.

v" The policy and research interest are always in gender, not sex, but examination

of data by sex is one of the means to making gender-based analyses.

Activity 1.1B: Gender Equality Versus Equity

i. Using a projector screen, display Figure 1 to the participants

il. Ask 3 to 5 participants to explain what the image means to them in the context
gender equality and equity.

iii. Summarise the interpretation, emphasising that:

Equality and equity are distinct concepts
Equality: Means providing the same resources to everyone.

Equity: Means adjusting resources based on individual needs to ensure fair
opportunities.

Reality: Reveals existing disparities that lead to significant inequalities in
outcomes.

Implication: Development efforts should focus on both gender equality and
equity because of the differences in the needs and capacities of women and
men.

iv. Ask participants to complete Exercise 1.1.B.

Activity 1.1C: Data, information, and statistics

I.  Ask 3 to 5 participants to explain their understanding of the concepts of data,
information, and statistics. Prompt them to provide definitions and examples.

Il. Display an electronic dataset and analysed data (information) to illustrate the
differences between the two concepts.

[ll. Then use Notes 1.1D to summarise the key differences, emphasising key points
and clarifying misconceptions.
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g Notes/ Handout 1.1Aa: Sex versus Gender

Although the words ‘sex’ and ‘gender’ are often used interchangeably, they mean

different things and it is important to choose the right word when discussing
sex and/or gender in the context of statistics. According to the Uganda Gender Policy
2007, sex refers to the biological characteristics that make an individual male or female.
Sex differences are God given, universal and unchangeable. The policy defines gender
as the social and cultural construct of roles, responsibilities, attributes, opportunities,
privileges, status, access to and control over resources and benefits between women
and men, boys and girls in each society.

Gender determines what is expected, allowed, and valued in a woman or a man in each
context (United Nations, 2013, p.2).

The policy and research interest are almost always in gender, not sex, but examination
of data by sex is the means to making gender-based analyses. Sex-disaggregated data
are needed to show the differences that exist between women and men in each society.
Data must be disaggregated by sex to analyse gender issues. However, this alone is not
always sufficient for gender analysis. A gender analysis includes examining the causes
and implications of the differences or inequalities. For example, the disaggregation of
victims of defilement by sex has some value, but information on the perpetrator and
their relationship to the victim is also needed to understand if the act was committed
in a family context or by someone unknown to the victim. Disaggregation of data using
other factors bring out intersectionality i.e. how these factors combine with gender to
compound differences and inequalities between women and men.

The concept of gender focuses not only on women and girls, but also on men and boys.
This is important because policies and programmes affect women and men differently
and because men’s position in society is an important context for understanding
women'’s position and vice versa. However, a focus on either men or women may also
be appropriate in some cases. For example, some issues pertain to women but not to
men, such as maternal mortality, while there are some health issues that are specific to
men such as testicular cancer.

ﬁ Notes/ Handout 1.1B: Gender Equality Versus Gender Equity

Gender equality is the ability of men and women, boys and girls to enjoy the

same status and have equal opportunity to realise their potential to contribute
to socio-cultural, economic and political development (The Uganda Gender Policy 2007).
Gender equality means equal opportunities, rights and responsibilities for women and
men, and girls and boys. Equality does not mean that women and men are the same, but
that the opportunities, rights and responsibilities of women and men do not depend on
whether they are born female or male (United Nations, 2002, as cited in United Nations,
2013, p.3). Gender equity is fairness and justice in the distribution of resources, benefits,
and responsibilities between men and women, girls and boys in all spheres of life (The
Uganda Gender Policy 2007).
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Figure 1: Gender equality, equity, and reality

Interpretation

Equality

o lllustration: Three individuals of different heights are each standing on one crate
to watch a baseball game over a fence.

e Concept: Equality means providing everyone with the same resources or
opportunities. However, because everyone has different needs and starting
points, equal treatment doesn’t necessarily lead to fair outcomes. In this case,
despite each person having a crate, not all can see over the fence due to their
varying heights.

Equity

e lllustration: The individuals are given different numbers of crates according to
their needs to ensure everyone can see over the fence. The shortest individual
gets more crates, the tallest one gets none, and the middle one gets one crate.

e Concept: Equity involves allocating resources and opportunities based on
individual needs, leading to fair outcomes. Here, the different crate distribution
ensures that everyone, regardless of height, can see the game.

Reality

o lllustration: This panel shows the tallest individual standing on multiple crates,
seeing the game comfortably, while the middle individual is still on one crate,
and the shortest individual now has no crates and is completely unable to see.

e Concept: Reality often reflects a significant disparity where resources and
opportunities are unevenly distributed, leading to an imbalance. The tallest

6 EMBEDDING GENDER STATISTICS IN DECISION-MAKING
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individual represents those who have excessive advantages, while the shortest
represents those who are significantly disadvantaged.

Summary Gender Equality Interpretation

e Equality vs. Equity: In the context of gender equality, the image highlights that
treating everyone the same (equality) doesn't address the different barriers that
individuals might face due to their gender. Equity, however, recognizes these
differences and seeks to provide support based on specific needs.

e Reality Check: The “reality” panel reflects the systemic inequalities that exist,
where some groups (often men in the context of gender) have more opportunities
and resources, while others (often women) have fewer resources and face more
significant barriers, making it harder for them to achieve the same outcomes.

Other Gender Concepts

Gender analysis is a critical examination of how differences in gender roles, activities,
needs, opportunities and rights/entitlements affect women, men, girls and boys in
certain situations or contexts. Gender analysis examines the relationships between
women and men and their access to and control of resources and the constraints
they face relative to each other. It also incorporates assessing the implications of a
proposed intervention on the status of women and men and the relative power balance.
Gender analysis may be conducted based on qualitative information' and methods and/
or based on quantitative? information provided by gender statistics.

Gender balance is commonly used in reference to human resources and the equal
participation of women and men in all areas of work, projects, or programmes. In a
scenario of gender equality, women and men are expected to participate in proportion to
their shares in the population. In many areas, however, women participate less than what
wouldbeexpectedaccordingtothesexdistributioninthe population (underrepresentation
of women) while men participate more than expected (overrepresentation of men).

Gender parity (or more accurately, sex parity) is a numerical concept. Gender parity
concerns relative equality in terms of numbers and proportions of women and men,
girls, and boys. Gender parity is often calculated as the ratio of female-to-male values
of a given indicator. When males-to-females ratios are calculated instead, the label “sex
ratio” is used instead of gender parity”. Gender (or sex) parity does not necessarily imply
gender equality. For example, equal numbers of men and women in the workforce, either
men or women might still face significant pay gaps, limited access to senior positions,
discrimination, and biases in recruitment and promotion processes.

Gender blindness is an approach that does not recognize or address the different
impacts policies or actions may have on women and men. For example, implementing a
workplace policy that does not consider the different impacts it might have on men and

1 Refers to non-numerical data that describes characteristics, qualities, or attributes of a subject rather than measuring
it with numbers. It focuses on descriptive aspects such as perceptions, experiences, behaviors, and meanings.

2 Quantitative data is numeric and used to quantify variables and phenomena. It allows for statistical analysis and aims
to identify patterns, relationships, and generalizable results. This type of data is more objective and is used to test
hypotheses and measure variables
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women, such as ignoring the need for maternity or paternity leave.

Gender neutral recognizes the need to treat women and men equally without emphasizing
differences. Aims to create a fair environment but may require additional measures
to address specific gender-based needs or disparities. For example, implementing a
workplace dress code that does not specify different rules for men and women but
focuses on overall appropriateness.

Gender issue: is a point of gender inequality or inequity and results from discrimination
or oppression of an individual or a group of people purely based on social expectations
and attributes. Gender issues should be the centre of analyses and policy decisions,
plans, programme budgets and institutional structures and processes. From a statistics
perspective, gender issues should also be at the core of plans and programmes for
developing gender statistics by national statistical systems.

Gender mainstreaming (general) is a strategy for making women’s as well as men’s
concerns and experiences an integral dimension of the design, implementation,
monitoring and evaluation of policies and programmes as well as in organisational
structures and procedures in all political, economic, and societal spheres so that women
and men benefit equally. The goal is to achieve gender equality.

Gender mainstreaming in national statistics means that gender issues and gender-
based biases are considered, systematically, in the production of all official statistics
and at all stages of data production.

Gender norms are the accepted attributes and characteristics of being a woman or a
man (ideas of how men and women should be and act) at a particular point in time for a
specific society or community. They are internalized early in life through the process of
gender socialization, are used as standards and expectations to which women and men
should conform and result in gender stereotypes.

A variable

A variable is an element or factor that can vary or change and is not fixed (UN

Women, 2020). In statistics, a variable is any factor that can have multiple
values. For example, age, as someone canbe, 1,11,33,100 years old, etc. Other examples
of variables are sex, marital status, and household size. A variable may also be called
a data item. When working with survey data, each of the survey questions is typically a
variable, although some variables are composites (combinations) of several questions.

9 Notes/ Handout 1.1C: Concepts in Gender Statistics

Official versus non-official statistics

Official statistics are those statistics that are produced, disseminated, and used by
government agencies to provide a reliable picture of society and the economy. They
are fundamental to the development of evidence-based policies and decision-making
processes. Official statistics are also important for the transparency and accountability
of government actions and for the democratic process (UNECE, 2018). In Uganda’s
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context, official statistics are statistics produced either by the Uganda Bureau of
Statistics or another government body in charge of data production (e.g. line ministries,
Bank of Uganda, etc.). They are usually produced in accordance with the Uganda Bureau
of Statistics Act 1998 and in line with the Fundamental Principles of Official Statistics
(UBOS, 2021). In select cases, official statistics might also be produced by third-party
organisations, such as private sector entities, civil society organisations or academic
institutions, with the involvement of UBOS. It is important to note that, in these cases,
UBOS’ involvement and validation of such statistics is essential for the figures to be
treated as ‘official’. Some examples of official statistics include:

1. Figures derived from Census data.
2. Estimates derived from official surveys.

3. Aggregates calculated using administrative records compiled by government
institutions (e.g. birth registration, crime statistics)

4. Increasingly, select official statistics are also starting to be produced using
nonconventional sources (e.g. big data, citizen generated data, crowdsourcing,
etc.). Although these data sources have great potential, it is important to
complement them with other traditional forms of statistics to avoid bias and
ensure comprehensive population coverage.

5. Expert assessments. These typically refer to professionals such as academics,
lawyers or civil servants who answer a questionnaire in the area of interest
(UNECE, 2016)

Non-official statistics are those produced without any involvement of the national
statistics body or any other member of the National Statistical System (UNECE, 2018).
Thus, any statistics produced without the involvement of UBOS or other mandated
entities in Uganda are considered non-official statistics. These statistics are often
narrower in coverage, as sample sizes tend to be larger in data collection exercises
conducted by UBOS (due to availability of financial and human resources for data
collection). While most official statistics tend to be produced periodically (e.g. the
Census often takes place once a decade, demographic surveys often have a five-year
periodicity), non-official statistics are more likely to be ad-hoc studies and one-off data
collection exercises.

Data Users vs Data Producers

Data users

Any consumer of data is generally considered a data user. Data Users are individuals
or organizations that utilize statistical data for programming, decision-making, policy
development, research, and public information. They include policymakers, researchers,
civil society organizations, and the public (UN Women, 2019). The most common users
of gender data include policymakers and other forms of decision-makers, government
bodies, civil society organisations, academics and researchers, private-sector
institutions, and international organisations.

EMBEDDING GENDER STATISTICS IN DECISION-MAKING 9
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Data producers

Data Producers are entities responsible for collecting, processing, and disseminating
statistical data. They primarily include national statistical offices, government agencies,
and research institutions (UN Women, 2019). In Uganda, data producers include UBOS,
line ministries, other government departments, some international organisations and, in
rare instances, the private sector and civil society organisations that generate statistics.

Drawing the line between data users and producers is not always easy, as many actors
can both be users and producers. For instance, the Uganda Police force is a data user
because it consumes statistics from the crime statistics system generated by different
governance and security institutions including the judiciary, Office of the Directorate
of Public Prosecution for instance to estimate the prevalence of a certain disease.
However, it is also a data producer because it generates administrative crime data and
compiles it through the Annual crime report. Institutions are therefore located along the
continuum of data production and use, with some tending more towards production and
others tending more towards consumption. There are also those actors in the middle-
information brokers who repackage available information for users.

In this training manual, data users are officers who process information input for policy

and other forms of decision-making in government and policy influencers outside
government (See users of the manual in the Introduction Part).

g Notes/ Handout 1.1D: Data, Information, and Statistics
Data are measurements, observations, or raw facts that have not been
organised, processed, or analysed. There are various ways of classifying data

as shown in Figure 2 below.

Figure 2: Types of Data

Tha uyumw

Intellspot. com

Source: Valcheva (n.d.)
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Information is processed and organized data that has been given context, relevance, and
meaning. It is the result of analysing, interpreting, and presenting data in a structured
manner to make it meaningful and useful for decision-making or understanding. For
instance, a summary of births by region, along with trends and analysis, transforms raw
birth data into actionable information for government decisionmakers.

Figure 3: Difference between Data and Information

‘What is the difference between data
-and information?
Source: Roddewig (2012)

Statistics is a branch of mathematics that deals with the collection, analysis,
interpretation, presentation, and organization of data. It involves techniques for
summarizing, describing, and drawing conclusions from data. Statistical methods are
used to analyse data, identify patterns, make predictions, and infer relationships. In
a broader sense, statistics also refer to numerical facts or data used for reference or
comparison. For example, unemployment rate, average income, or population growth
rate are all statistical measures derived from data collected through surveys or expert
assessments/studies.

- Exercise 1.1Aa: Sex vs Gender
E i.  To monitor participants’ learning progress, ask them to complete

Exercises 1.1Aa either individually or in pairs. The facilitator can also
administer Exercise 1.1Aa as an online quiz on Mentimeter, Survey Monkey,
Google Forms, or any other relevant online survey platform.

For each statement, indicate if they refer to sex or gender:
1. Women can become pregnant. Men can make them pregnant. Sex  Gender

2. Childcare is the responsibility of women. Men should be concerned with paying
school fees. Sex  Gender

3. Women do most agricultural work in African countries. Sex  Gender
4. Women make good leaders. Sex Gender

5. Women can breastfeed babies. Men can bottle-feed babies. Sex Gender

EMBEDDING GENDER STATISTICS IN DECISION-MAKING 11
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= Exercise 1.1Ab: Sex vs Gender
E i.  To monitor participants’ learning progress, ask them to complete

Exercises 1.1Ab either individually or in pairs. The facilitator can also
administer Exercise 1.1Ab as an online quiz on Mentimeter, Survey Monkey,
Google Forms, or any other relevant online survey platform.

Fill in each blank space with the word ‘sex’ or ‘gender’, as relevant.

1. After delivery, the doctor will reveal to the mother the of the child.

2. To understand the differences in enrolment rates between girls and boys, the
data must be disaggregated by .

, but some countries
dimensions and apply

3. Dataistypically disaggregated by binary definitions of
are starting to develop methodologies to capture
these for disaggregation.

4. Women and men's
doing domestic work.

roles in society determine how much time they spend

5. statistics include -disaggregated statistics and other
-specific indicators that capture the realities and the differences in the
lives of women and men.

For each scenario below, indicate if they refer to gender equality or gender

S Exercise 1.1B: Gender Equality vs Gender Equity
E equity:

1. In a company, men and women receive the same salary for the same position.
Gender equality Gender equity.

2. The Government of Uganda provides 1.5 top up points to women to enable more
women access to university and tertiary education. Gender equality
Gender equity.

3. A healthcare campaign provides free screening for breast cancer, a disease
predominantly affecting women. Gender equality  Gender equity.

4. The Government of Uganda reserves 30% of elective positions in the local
government and national parliament for women to enable more women access
to decision-making positions. Gender equality Gender equity.

5. A company provides the same number of paid parental leave days for both
mothers and fathers. Gender equality Gender equity.

6. A microfinance initiative specifically targets women in rural areas to provide
them with access to financial services. Gender equality = Gender equity.

7. The Gender and Equity Budget Guidelines requires Government ministries,
agencies and departments to budget for activities and services that meet the
diverse needs of women and men. Gender equality Gender equity.

8. Establishing dedicated shelters, hotlines, and counseling services specifically
for male victims of domestic violence. Gender equality Gender equity.
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A Facilitator Guide for Training of Users of Gender Statistics in Uganda



Answers to Exercise 1.1Aa: Sex vs Gender

For each statement, indicate if they refer to sex or gender:
Women can become pregnant. Men can make them pregnant. Sex

Childcare is the responsibility of women. Men should be concerned with paying
school fees. Gender

Women do most agricultural work in African countries. Gender
Women make good leaders. Gender

Women can breastfeed babies. Men can bottle-feed babies. Sex

Answers to Exercise 1.1Ab: Sex vs Gender (Answers)

Fill in each blank space with the word ‘sex’ or ‘gender’, as relevant.

After delivery, the doctor will reveal to the mother the __sex of the child.

To understand the differences in enrolment rates between girls and boys, the
data must be disaggregated by __sex____.

Data is typically disaggregated by binary definitions of _sex___, but some
countries are starting to develop methodologies to capture __gender
dimensions and apply these for disaggregation.

Women and men's __gender. roles in society determine how much time they
spend doing domestic work.

Gender statistics include __sex -disaggregated statistics and other
__gender -specific indicators that capture the realities and the differences
in the lives of women and men.

Answers to Exercise 1.1B: Gender Quality Vs Equity (Answers)

For each scenario below, indicate if they refer to gender equality or gender
equity:

In a company, men and women receive the same salary for the same position.
Gender equality because scenario addresses equal treatment regardless of gender.

The Government of Uganda provides 1.5 top up points to women enable more
women access to university and tertiary education. Gender equity because this
“affirmative action” initiative aims to address the specific needs and barriers faced
by women to achieve parity in education.

A healthcare campaign provides free screening for breast cancer, a disease
predominantly affecting women. Gender Equity because this campaign focuses on
addressing the specific health needs of women, aiming for fairness in healthcare
access.
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4. The Government of Uganda reserves 30% of elective positions in the local
government and national parliament for women to enable more women access
to decision-making positions. Gender equity because this “affirmative action”
initiative aims to address the specific needs and barriers women'’s participation in
representative politics.

5. A company provides the same number of paid parental leave days for both
mothers and fathers. Gender Equality because both parents receive the same
benefits, reflecting equal treatment regardless of gender.

6. A microfinance initiative specifically targets women in rural areas to provide
them with access to financial services. Gender Equity because this initiative aims
to address the specific economic needs and challenges faced by women, aiming for
fair access to financial resources.

7. The Gender and Equity Budget Guidelines requires Government ministries,
agencies and depart5ments to budget for activities and services that meet the
diverse needs of women and men. Gender Equity because these guidelines aim to
provide services to both women and men, based on their needs.

8. Establishing dedicated shelters, hotlines, and counseling services specifically for
male victims of domestic violence. Gender equity because these programmes are
designed to provide a safe space and the necessary support for men who experience
abuse, recognizing that they face unique challenges and stigma.

SESSION 1.2 GENDER STATISTICS AND ITS IMPORTANCE

Session objective: Enable participants to understand,
e The concept of gender statistics.

e How gender statistics is important in achieving gender
equality and women’s empowerment.

Methods: Video screening and plenary brainstorming

Requirements: A projector, a computer, internet access for the facilitator &
participants, an audio device, flipchart papers, and marker pens.

Preparation: Before the session, identify a suitable video on gender statistics
when planning the training event.

Duration 60 minutes

Activity 1.2 Definition and importance of gender Statistics

Notes/Handouts  1.2A: Definition of gender statistics

1.2B: Importance of gender statistics
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Activity 1.2 Definition and importance of Gender Statistics

i. Request the participants to watch a video. A sample video is here provided:
Definition and importance of Gender Statistics: https://youtu.be/wT5nAjpVQjw

ii. Then ask them to mention what they heard regarding the definition of gender
statistics.

iii. Finally, ask the participants to list how gender statistics are used, as narrated in
the video. You may capture these on a flipchart.

iv. Conclude the Q&A, referring to the guidance Notes 1.2.A and 1.2.B

9 Notes/ Handout 1.2A: Definition of Gender Statistics

Gender statistics are defined as statistics that adequately reflect differences

and inequalities in the situation of women and men in all areas of life (United
Nations, 2006, as cited in United Nations, 2013, p.1). It is a field of statistics which cuts
across the traditional fields to identify, produce and disseminate statistics that reflect
the realities of the lives of women and men, and help in raising policy issues related to
gender equality.

Gender statistics are defined by the sum of the following four characteristics:

a) Data are collected and presented with disaggregation by sex as a primary
and overall classification. Sex-disaggregated statistics are data collected and
tabulated separately for women and for men.

b) Data collected reflects gender issues.

c) Data are based on concepts and definitions that adequately reflect the diversity
of women and men and capture all aspects of their lives.

d) Data collection methods consider stereotypes and social and cultural factors
that may induce gender biases.

Therefore, gender statistics go well beyond just being statistics about women, or sex-
disaggregated data.
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Gender sensitive concepts and methods of data collection consider the diversity of
various groups of women and men and their specific activities and challenges and aim
to reduce sex and gender bias in data collection, such as the underreporting of women's
economic activity, the underreporting of violence against women and the undercounting
of girls, their births, or their deaths.
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ﬂ Notes/ Handout 1.2B: Importance of gender statistics

Gender statistics are essential in making informed decisions across the phase
of planning, implementation, monitoring, and evaluation. Gender statistics are
therefore necessary to:

a) ldentify critical gender issues and inequalities to inform advocacy for inclusive
and effective policies that meet the needs of all women and men.

b) Develop programmes/ projects to promote gender equality and women'’s
empowerment for example through mainstreaming of gender equality and
womens empowerment in National Development Plans (NDP).

c) Hold the government accountable for her commitments, including the
achievement of the Sustainable Development Goals (SDGs) and the National
Development Plan (NDP).

d) Conduct analysis and academic research on the differentiated characteristics
of the lives of women and men to increase knowledge base of gender issues to
inform policy and programming at the country level

e) Report at the institutional and national level (e.g. reports submitted to sector
ministries and donors) and report on regional and international human rights
instruments e.g. SDGs and African Union Agenda 2063.

f) Monitor and evaluate performance of policies, plans, or programmes, regardless
of their focus on gender.

g) Inform capacity strengthening on gender equality and women's empowerment.

SESSION 1.3: FOUNDATION: INTEGRATING A GENDER PERSPECTIVE IN

STATISTICS

Session objective: Enable participants to understand the data value-chain.
Methods: Lecture, QA

Requirements: A projector

Preparation: Beforethe session, the facilitator should prepare a PPT onintegrating
a gender perspective in statistics.

Duration 50 minutes

Activity 1.3 Integrating a gender perspective in Statistics

Notes/Handouts 1.3 The Data Value-Chain
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Activity 1.3: Integrating a gender perspective in Statistics

i. Deliver a lecture on integrating a gender perspective in statistics, using a prepared
PPT.

il. You can make the presentation interactive, by allowing Q&A during the delivery.

iii. Afterthe presentation, ask participants for any additional questions they may have.

ﬂ Notes/ Handout 1.3: The Data Value-Chain

Official gender statistics produced at the country level draw on three main

data-collection instruments: administrative records or registries, household
surveys and population census. Increasingly, new, and emerging data sources — such
as Big Data sources, citizen generated data and geospatial information — are also being
utilized to produce official statistics but these are beyond the scope of this manual.

Although this manual focuses on data use, it is important to note that mainstreaming
requires integrating a gender perspective at all stages of the statistical cycle/ data
value chain from data collection to analysis and use. This addresses and minimizes
the scope for any form of gender bias in the data. Hedman, et al (1996) and United
Nations, Economic Commission for Europe, and World Bank Institute (2010) suggest
the following steps of the data cycle:

a) Selection of topics to be investigated.

b) Identification of statistics to be collected to reflect the gender issues e.g.
Violence against women, FGM, etc.

c) Evaluation of existing concepts, definitions, and methods to produce unbiased
gender relevant information.

d) Formulation of new concepts and definitions that adequately reflect the
diversities of women and men in society.

e) Development of data collection methods that consider stereotypes and social
and cultural factors that might produce gender-based biases.

f) Collection and processing of data using practices that will deliver reliable results
and presentation of statistics in easy-to-use formats; dissemination of statistical
products to a wide range of users including policymakers and planners.
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The statistical process can be represented by the data value chain and is illustrated
below:

MODULE ONE
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Figure 4: Data Value Chain
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Source: Open Data Watch (n.d.)

The above image underscores the importance of integrating gender considerations at
every stage of the data cycle—from collection to impact—organizations can ensure that
data not only reflects gender differences but also contributes to informed decision-
making and policy development that supports gender equality.

Users are mainly interested in the step of uptake, which encompasses disseminating,
connecting, incentivizing, and influencing the use of data. This is followed by the Impact
phase, entailing the use, change, and reuse of data, which includes promoting data
culture, tracking behaviour changes, and identifying data-driven policies.
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MODULE TWO: ANALYSING MACRODATA
SOURCES FOR GENDER STATISTICS
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LEARNING OBJECTIVES/OUTCOMES
After completing this Module, the participants are expected to have:

* Gained familiarity with the concepts of macrodata, microdata, and
metadata.

«  Become familiar with the concepts of good-quality data and good
sources of global and national gender data.

* Understood how to conduct basic analysis of gender data from
secondary sources.

+ Understood how to access the available interactive data portals and
how they can conduct basic data analysis and visualization.

« Appreciated the importance of using metadata when analysing and
interpreting secondary data accurately.

OVERVIEW OF THE MODULE

The module covers the concepts of Macrodata, Microdata and Metadata,
existing data sources in Uganda including their type and data collection
methods, how to identify sources of good quality gender statistics, how to
extract gender statistics from processed microdata including reports and
how to analyze pre-processed datasets to generate gender statistics

NOTE TO FACILITATOR

In statistical analysis, data is categorized into two main types: macrodata
and microdata. Macrodata consists of aggregated statistics representing
a larger population.This data is typically compiled by national statistical
offices like the Uganda Bureau of Statistics (UBOS) and is readily available
through reports, surveys, and online databases. Sources of macrodata
include national censuses, household surveys, statistical abstracts, and
administrative records from various government ministries and agencies.
Additionally, international platforms such as the UN Women Data Portal,
World Development Indicators, and SDG Global Indicators Database provide
globally comparable macrodata.

Microdata, on the other hand, consists of individual-level records where each
row in a dataset represents a person, household, or organization, and each
column captures attributes like age, gender, or employment status. However,
accessing microdata often requires formal requests and adherence to
confidentiality agreements. Both macrodata and microdata rely on metadata,
which provides essential contextual information about how data is collected,
defined, and classified. Understanding these concepts is crucial for effective
statistical analysis and informed decision-making in various fields, including
gender statistics, health, and economic planning
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T |
: 9HOURS

SESSION 2.1: THE CONCEPTS OF MACRODATA, MICRODATA AND METADATA

Session objective: Enable participants to:

a) Understand and differentiate the concepts of macrodata,
micro data, and metadata.

b) Identify the key sources of datasets and metadata.
Methods: Plenary brainstorming and a facilitator's presentation.

Requirements: A projector, a computer, internet access for the facilitator &
participants, and an audio device.

Preparation: Before the session the facilitator should:

e Prepare a PPT on the concepts of macrodata, micro data,
and metadata

e Prepare online links or extracts of examples of macro, micro
and meta data

Duration 60 minutes
Activity 2.1: Macro versus micro data

Notes/Handouts 2.1A Macro vs Microdata
2.1B: Metadata

Activity 2.1: Macro versus micro data

i. Ask 3 to 4 participants to define the concepts of macro and micro data.

ii. Deliver a presentation on the concepts of macro and micro data, guided by
Notes 2.1A

iii. Ask participants to raise questions and address them.
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ﬂ Notes/ Handout 2.1A Macro vs Microdata

In statistical contexts, two primary types of data are used to describe data

granularity—the level of detail or precision in a dataset—macrodata and
microdata. Macrodata is aggregated data usually obtained from aggregating individual-
level records into a figure that is representative of a population group. Some of the
most widely used statistics are macrodata. For instance, figures about on proportion
of men, women and children of all ages living in poverty in all its dimensions according
to national definitions, proportion of ever-partnered women and girls aged 15 years and
older subjected to physical, sexual or psychological violence by a current or former
intimate partner in the previous 12 months, by form of violence and by age, proportion of
time spent on unpaid domestic and care work, by sex, age and location, Uganda'’s total
fertility rate, unemployment rate, or mortality rates are all macrodata, as a single value
is representative of the country (e.g. individual values have been aggregated to come
up with a single value that is nationally representative). Simply put macro are national
level while micro is sub-national.

Table 1: Examples of macrodata in Uganda’s Statistical System

Indicator Year and Source Value (Women) Value (Men)
Total Fertility Rate 2022 (UDHS) 4.1 N/A
Under-five Mortality 2022 (UDHS) 50/1000 57/1000
Life Expectancy at Birth 2022 (UDHS) 65.7 61.2
Unemployment rate 2021/2 (NLFS) 14.1 10.4
Multi-dimensional poverty Multi poverty 50 % for 39 % for
rate Dimensional Index Report female headed male headed
2022 households households
Proportion of time spent on Time Use Survey 2019 6.6 hours 5.1 hours

unpaid domestic and care
work, by sex, age and location

The proportion of women and UDHS 2022 48% 40%
men that experience physical
and sexual violence

When national estimates are disaggregated by sex, location, geographical unit, or
other variables, this is still macrodata. Macrodata aggregates are often prepared by a
country’s National Statistics Office (UBOS in Uganda) or other members of the National
Statistical System. You should choose macro data when you are looking for readily
available estimates, representative of a country or select groups within the country.

Data sources in Uganda

e Printed and electronic reports of national censuses and nationally representative
surveys conducted by UBOS. These include:

o Uganda National Population and Housing Census (UNPHC)- carried out
every 10 years.
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Uganda National Household Survey (UNHS). This survey collects data on
household demographics, living conditions, employment, education, health,
and other socio-economic indicators. It's typically conducted every three to
four years.

Uganda Demographic and Health Survey (UDHS). Gathers data on fertility,
family planning, maternal and child health, nutrition, and other health-related
indicators. It's conducted every five years.

The Uganda National Panel Survey (UNPS). This longitudinal survey follows
the same households over time to track changes in various socio-economic
indicators, including poverty, employment, education, and health.

Other irregular census/surveys: National Livestock Census; Uganda National
Service Delivery Survey (UNSDS); Uganda National Labour Force Survey,
Agricultural Censuses, critical gender statistics needed since our economic
base is largely still agriculture. For example, one would be interested in what
is happening with the coffee boom! If they are irregular, then how do we
establish trends? Or it is because of limited resources that we are not able
to undertake them regularly

Targeted surveys: Targeted for specific issues that affect women OR men
that are not captured in traditional surveys e.g. Uganda has so far conducted
the time use survey 2019 on care work, National Survey on Violence in
Uganda 2021 Module one on Violence Against Women and Girls,, National
Governance, Peace, security survey | in 2017 and 1l in 2024 on access to
justice, political participation and women economic empowerment

Statistical abstracts and reports

O

O

O

UBOS Statistical Abstract. This abstract provides a comprehensive overview
of key statistics across various sectors including demographics, economy,
health, education, agriculture, and more.

MOES Education Statistical Abstract
The Police Annual Crime and Road Safety Report

Annual Report of the Uganda Human Rights Commission to the Parliament
of Uganda

Annual Education and Sports Sector Performance Report
Annual Health Sector Performance Report
Annual JLOS Performance Report

National Development Plan Performance Reports

Administrative data systems

A) Online databases/ Management Information Systems of Government -

Ministries Departments and Agencies and Local Governments including
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o Health Management Information System (HMIS)

o Education Management Information System (EMIS)

o Integrated Financial Management Information System (IFMS)

o Gender-based Violence Management Information System (GBV MIS)

o Orphans and other Vulnerable Children Management Information System
(ovC MIS)

o National Identity Card System

o Land Information System (LIS)

o National Agricultural Management Information System (NAMIS)
o Crime Statistics System

o Refugee Information Management System

B) Administrative data from non-state actors through innovative sources such
as citizen generated data from Civil Society Organizations and private sector

e Expert assessments. These typically refer to professionals such as academics,
lawyers or civil servants who answer a questionnaire in the area of interest.
The resort to experts is thought to be advantageous because they can assess
complex topics related to gender equality and women empowerment. Examples
include the

e Compliance with planning and budget tools for tracking public allocations for
gender equality and women’'s empowerment: Uganda’s case 2020

Through the UBOS website, data users can directly download estimates for various
gender statistic-related indicators, as well as many other thematic indicators based on
their sources and data from other official producers, such as line ministries. Some of
the databases include:

e Gender Statistics Portal (ubos.org)

e Gender Based Violence Incidence Dashboard - till 2021 (ubos.orq)

e NSO Open Data: nso.uganda.opendataforafrica.org
e National Summary Data Page: nso.uganda.opendataforafrica.org

The UBOS website also serves as a communication channel through which
audiences are informed of new data releases, publications, and other
knowledge products.

The Statistical Resource Center (SRC)' at UBOS houses information materials for both
the Uganda Bureau of Statistics (UBOS) and National Population Council. Its opening
hours (Monday to Friday only): morning: 9am to 1pm; afternoon: 2pm to 5pm.
International sources

1 Resource Center - Uganda Bureau of Statistics (ubos.org)
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Some links to online repositories for internationally comparable macrodata that
comprises gender statistics include:

1. UN Women's data portal: https://data.unwomen.org/data-portal

2. Official SDG Global Indicators Database: https://unstats.un.org/sdgs/indicators/
database/

3. World Development Indicators: https://data.worldbank.org/

4. DHS STATcompiler https://www.statcompiler.com/en/

5. Websites of specialized UN agencies: (e.g. UNICEF for children, UNESCO for
education, WHO for health, etc.)

Micro data are data on individual study units. The unit could be an individual person,
population group, or a company. For example, on an individual person in a typical survey
dataset, each row represents the person and each column an attribute such as age,
gender, or job type. Microdata is an option when the aggregated data of interest is not
available from official statistics or if one is interested in further statistical analysis.

Both macrodata and microdata are stored in databases, online repositories, and data
servers. While macrodata is often openly available online, accessing microdata might
entail submitting a formal request to the data custodians and signing a confidentiality
agreement.

9 Notes/ Handout 2.1B: Metadata

Metadata refers to the range of information, generally textual, that fosters

understanding of the context in which statistical data have been collected,
processed, and analysed with the objective of creating statistical information. It is
the legal and regulatory texts, methods and concepts used at all levels of information
processing, definitions, and nomenclatures, etc.). In other words, metadatais information
about data. Metadata might provide information about an indicator, a data series, or a
data point. The Uganda Bureau of Statistics produces metadata handbooks including
for Sustainable Development Goals in 2022 and the National Gender Equality Priority
Indicators of Uganda 2016 and 2019. These handbooks includes information on the data
compiler, production timeliness, definitions, computation methods, quality assurance,
and any statistical limitations. Metadata allows comparability across different datasets
and overtime

Indicator metadata: What does it usually include?
1. Official indicator name

2. Definitions

3. Rationale

4. Methods of computation / Formulas
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5. Information about exceptions, methodological concerns and limitations

6. Information about usual data sources utilized to derive the indicator.

7. If the metadata refers to an SDG indicator, it often also includes information
about custodian agencies and methodology for producing regional aggregates.

Figure 5: Sample 1 for Indicator Metadata

Goal 3: Ensure healthy lives and promote well-being for all at all ages
Target 3.1: By 2030, reduce the global maternal mortality ratio to less than 70 per 100,000 live births
Indicator 3.1.1: Maternal mortality ratio

Institutional information

Organization(s):

World Health Organization (WHO)

Concepts and definitions

Definition:

The maternal mortality ratio (MMR) is defined as the number of maternal deaths during a given time
period per 100,000 live births during the same time period. It depicts the risk of maternal death relative
to the number of live births and essentially captures the risk of death in a single pregnancy or a single live
birth.

Maternal deaths: The annual number of female deaths from any cause related to or aggravated by
pregnancy or its management (excluding accidental or incidental causes) during pregnancy and childbirth
or within 42 days of termination of pregnancy, irrespective of the duration and site of the pregnancy,
expressed per 100,000 live births, for a specified time period.

Rationale:

All maternal mortality indicators derived from the 2015 estimation round include a point-estimate and an
80% uncertainty interval (Ul). For those indicators where only point-estimates are reported in the text or
tables, Uls can be obtained from supplementary material online
(http:/fwww.who.int/reproductivehealth/publications/monitoring/maternal-mortality-2015/en/). Both
point-estimates and 80% Uls should be taken into account when assessing estimates.

For example:
The estimated 2015 global MMR is 216 (Ul 207 to 249)

Source: UN WOMEN (2022). Curriculum on Gender Statistics Training; Module 9, Finding the Right
Gender Data and Conducting Basic Analysis
Sample 2 for Indicator Metadata

Source: Uganda Bureau of Statistics (2022): Metadata Handbook for Sustainable
Development Goals (p. 124-125)

SDG INDICATOR 5.1.1: whether or not legal frameworks are in place to promote,
enforce and monitor equality and non-discrimination on the basis of sex.

0.a. Goal 5: Achieve gender equality and empower all women and girls

0.b. Target 5.1: End all forms of discrimination against all women and girls everywhere
0.c. Indicator 5.1.1: Whether or not legal frameworks are in place to promote, enforce
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and monitor equality and non-discrimination on the basis of sex
0.d.Data Series: Year

2015 12
2016 12
2017 12
2018 12
2019 12
2020 12

Metadata update December 2021

0.f. Related indicators Indicator 5.a.2 and 5.6.2

0.g. international organization(s) responsible for global monitoring UN Women, World
Bank Group, OECD Development Centre

2. Definition, concepts, and classifications

2.a. Definition and concepts Definitions: Indicator 5.1.1 measures Government efforts
to put in place legal frameworks that promote enforce and monitor gender equality.
The indicator is based on an assessment of legal frameworks that promote, enforce
and monitor gender equality. The assessment is carried out by national counterparts,
including UBOS and/or National Women’s Machinery (NWMs), and legal practitioners/
researchers on gender equality. Concepts: Article 1 of CEDAW provides a comprehensive
definition of discrimination against women covering direct and indirect discrimination
and article 2 sets out general obligations for States, on required legal frameworks,
to eliminate discrimination against women. Article 1 of CEDAW states: “ the term
“"discrimination against women” shall mean any distinction, exclusion or restriction
made on the basis of sex which has the effect or purpose of impairing or nullifying the
recognition, enjoyment or exercise by women, irrespective of their marital status, on a
basis of equality of men and women, of human rights and fundamental freedoms in the
political, economic, social, cultural, civil or any other field”. The term “legal frameworks”
is defined broadly to encompass laws, mechanisms and policies/plans to ‘promote,
enforce and monitor’ gender equality.

Legal frameworks that “promote” are those that establish women's equal rights with
men and enshrine nondiscrimination based on sex. Legal frameworks that “enforce
and monitor’ are directed to the realization of equality and non-discrimination and
implementation of laws, such as policies/plans, establishment of enforcement and
monitoring mechanisms, and allocation of financial resources. This measures whether
or not: 1) national laws exist to promote gender equality and non-discrimination against
women and girls 2) there exist mechanisms to ‘enforce and monitor’ the implementation
of legal frameworks for each area of law.

2.b. Unit of measure Number

2.c. Classifications Not Applicable

3. Data source, type and data collection method
3.a. Data sources: The data for the indicator are derived from expert assessments of

legal frameworks using primary sources/official government documents, in particular
laws, policies/action plans on gender equality. The areas of law and questions are drawn
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from the international legal and policy framework on gender equality, in particular the
Convention on the Elimination of All Forms of Discrimination against Women (CEDAW),
which has 189 States parties, and the Beijing Platform for Action.

3.b. Data Collection method Countries are asked to designate a focal point to undertake
the coordination at the country level necessary for the collection and validation of
the data. Most designated focal points are within the NWMs, a number are within the
NSOs and some are within both the NWMs and the NSOs. After verification, the data
with relevant laws, polices and other sources included, is sent to the designated focal
points/country counterparts to review and validate. Final answers are arrived at after
the process of validation with country counterparts.

3.c. Data collection calendar Annual
3.d. Data release calendar First quarter of the next financial year.

3.e. Data providers UN Agencies, NGOs, other MDA and LGs 3.f. Data compilers Ministry
of Gender, Labour and Social Development

3.g. Institutional mandate The Ministry of Gender Labour and Social Development is
responsible for empowering communities to harness their potential through cultural
growth, skills development and labour productivity for sustainable and genderresponsive
development.

SDG INDICATOR 3.6.1: DEATH RATE DUE TO ROAD TRAFFIC

0. Indicator information
e 0.a. Goal 3: Ensure healthy lives and promote well-being for all ages

e 0.b. Target 3.6: Target 3.6: By 2020, halve the number of global deaths and
injuries from road traffic accidents

e 0.c. Indicator 3.6.1: Indicator 3.6.1: Death rate due to road traffic
e 0.d. Data Series:

e Year 2016

e Male 46

e Female7

e Total 53

e 0.e. Metadata update November 2021

e 0.f. Related indicators 3.5,11.2

e 0.g. International Organisations (s) responsible for global monitoring: World
Health Organization (WHO)

2. Definition, concepts, and classifications
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e 2.a. Definition and concepts Definition: Death rate due to road traffic injuries is
the number of road traffic fatal injury deaths per 100,000 populations. Concepts:
Road fatality means any person killed immediately or dying within 30 days as a
result of a road injury accident.

e 2.b. Unit of measure Rate per 100 000 population

e 2.c. Classifications None

3. Data source, type, and data collection method
e 3.a. Data sources The Uganda Demography and Health Survey (UDHS)

e 3.b. Data Collection method Sample Design. Out of the 20,880 selected
households (30 households per EA), 18,506 women aged 15-49 were successfully
interviewed.

e 3.c. Data collection calendar Every 5 years
e 3.d. Datarelease calendar 2022
e 3.e. Data providers Uganda Bureau of Statistics

e 3.f. Data compilers Uganda Bureau of Statistics, ICF

1. Other methodological considerations

4.a. Rationale Road traffic injuries remain an important public health problem, particularly
for low-income and middle-income countries.

4.b. Comment and limitations Calculated per 100,000 population Data on vital
registration is not comprehensive in terms of coverage to make comparison against the
data received from the survey.

4.c. Method of computation Absolute figure indicating the number of people who die as
a result of a road traffic crash per 100,000 population. Death rate due to road traffic =
(Total number of deaths due to road traffic crashes) (Total Population) x100, 000

4.d. Validation A wide consultative process is undertaken to compile, assess and
validate data on the indicator. The consultation process solicited feedback directly
from other Government Agencies responsible for official statistics, on the compilation
of the indicators, including the data sources used, and the application of internationally
agreed definitions, classification and methodologies to the data from that source. The
results of this Indicator consultation are reviewed by the Ministry of Health and UNICEF.

4.e. Adjustments N/A.
4.f. Treatment of missing values (i) at country level and (ii) at regional level None
4.9. Regional aggregations: Not applicable

4.h. Methods and guidance available to countries for the compilation of the data at the
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national level: None

2. Data availability and disaggregation
e Data Availability: Data available every 5 years
e Time Series: 2016

e Disaggregation: By age-group, sex, location (Rural-Urban), 15 sub regions

3. Comparability/deviation from international standards
° None
4. References and documentation

e URL: Uganda Demographic and Health Survey 2016 [FR333] (ubos.org)

Sources of Indicator Metadata

a) Inon-line repositories (e.g. https://unstats.un.org/sdgs/metadata/)

b) In indicator handbooks, normally developed to accompany indicator sets.
For example, an excerpt of the metadata for indicator 5.4.1 is given below. It
elaborates on the method of calculating the estimates.

Sources of Data point Metadata
1. Information about specific data points
Explanation about exceptions

2

3. Information about coverage
4. Methodological limitations
5

Specific details about a data point

Data point metadata where can you find it?
a) Inthe form of footnotes
b) Alongside data tables or in data cells
c) Insurvey reports

d) Example: data point metadata the proportion of time spent on unpaid domestic
and care work, by sex,age and location is 6.6 hours for women and 5.1 hours for
men.

e) Source: Time Use Survey 2019.

f)  proportion of people living in extreme poverty, disaggregated by sex and age, for
the years 2009-2013
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Source: UNESCO Institute for Statistics 2017a.

Nates: Data refer to latest available from 143 countries. Data are based on headeounts (HC), except for Cango, India and Israel, which are based on full-
time equivalents (FTE). Data for China are based on total research and development (R&D) personnel instead of researchers. Data for Brazil are based on
estimations.

g) Institutional reports on administrative data

h) Gender assessment and research reports

Why is metadata important?

a) Metadata goves data meaningful: Without it, understanding data would be
impossible. Metadata such as the indicator's name, definition, and unit of
measurement is essential—without it, data becomes meaningless.

b) Metadata improves comparability of data: Differences in data and their
interpretation can arise due to the use of different definitions, concepts, units,
and classifications.

c) Metadata can provide information about inconsistencies in computation
methods: For instance, the SDG indicator on adolescent birth rates is defined as
the annual number of births to women and girls aged 15 to 19, per 1,000 women
and girls in the respective age group. The metadata for this SDG indicator,
however, clarifies that depending on the type of data source used to calculate
this indicator, the method of computation differs. E.g. the type may differ in age-

grouping

SESSION 2.2: IDENTIFYING SOURCES OF GOOD QUALITY GENDER STATISTICS

Session objective: Enable participants to appreciate the indicators of good quality data
and how to apply them.

Methods: Group work and a quiz
Requirements: Internet access, flip charts papers, marker pens, and masking tape.
Preparation: Before the session, the facilitator should prepare:

o alistofindicators/ characteristics of good data on a flipchart.

e Print outs of Exercise 2.2 for each participant or design it as
an online quiz.
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Activity 2.2: Good quality data

Steps

i. Divide the participants into groups of 5-8 and ask them to discuss the questions,
“What are the indicators or characteristics of good quality data?”

ii. Provide time for each group to present in plenary and to receive feedback from
other groups and the facilitator.

iii. Instruct participants to note their comments while each group presents, and to
offer feedback after all presentations.

iv. To assess participants’ learning, administer Exercise 2.2. Participants can
individually fill-in the answers on prepared sheets or discuss in pairs. Alternatively,
the Exercise can be administered online as a quiz on mentimeter, Google Forms,
survey monkey, or any relevant application.

g Notes/ Handout 2.2: Finding the ‘right’ gender data

Given the important role of gender data (Module One), it is imperative that the

data used by policymakers, advocates, scientists, and journalists is of good
quality. It is also important that the user is aware that not all data is good data. While
data quality is assessed in a case-to-case considering the research question, the type
of research, scope of research and one’s level of statistical literacy, all data users must
prioritize official statistics over non-official statistics whenever available. (Refer to
Module One to understand the differences between official and non-official statistics).
Official statistics are generally preferable because:

e They are more likely to be more representative of a country’s total population
because the National Statistics Offices and other official data producers have
direct access to Census data, which can be used as a sampling frame, and thus
their sampling methods return more accurate results. Units of enumeration and
the units of data collection are also adequately chosen to support the production
of data that would show meaningful gender differences by the statistical office
making closeness of statistical estimates to true values possible

e The collection of data is at the core of the National Statistics Offices’ (and
some line ministries’) mandates. This means that financial resources are often
allocated to support these exercises. The collection of gender data across large
population samples is generally quite expensive and National Statistical Offices
having substantial financial resources allocated to this endeavour is likely to
result in more representative results improving the quality of data produced.

e National Statistics Offices and other official producers engage large teams of
enumerators trained in data collection methods. This ensures that gender issues
and gender based biases are systematically taken into account in the production
of the statistics and at all stages of data production enhancing the quality of the
data

e Trained enumerators are best placed to obtain accurate answers from
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respondents and more trained enumerators (including enumerators of different
ethnic and linguistic backgrounds) means questionnaires can be rolled out
among larger population groups of different backgrounds and can yield more
accurate responses.

e Most official statistics tend to be produced periodically, as funds are allocated
accordingly by national governments.
When official statistics are not available (for example for new and emerging areas), or
there is a conflict of interest, you can turn to non-official statistics. For instance, when
a user wishes to find estimates about corruption within the public service, non-official
statistics are more likely to be available and reliable on this topic.

For every data source, a user should be concerned that such data meets specific quality
parameters. According to key sources, including the UN Statistical Quality Assurance
Framework (SQAF)' and IFAD (2022)? a good statistical output should be:

Relevant: The relevance of a statistical product (such as a dataset) is measured in
terms of whether it meets users’ needs. Relevant data should speak to your need as
a user and take into account the gender issues that you want to address. For users of
gender data, the first step in finding the ‘right’ data is to identify specific figures that help
answer research questions. For instance, if a data user wishes to know whether female
genital cutting is currently a common practice in Uganda, he/she should look for a data
point that speaks to the ‘proportion of girls and women aged 15-49 years who have
undergone female genital mutilation/cutting in Uganda as of 2023" is a relevant data
point. This further emphasizes the need to impart skills on undertaking Information
needs Assessments and Producer-User dialogues)

Coherent: The coherence of a statistical output reflects the degree to which it is
logically connected and mutually consistent with other statistical outputs. It means
that the dataset that has been produced is based on compatible concepts, definitions,
and classifications. The international statistical community has agreed definitions
and classifications for numerous statistical concepts to ensure that gender data
is internationally comparable. For instance, when working with time-use data, the
statistical community has agreed to use the International Standard Classification of
Time Use Statistics (ICATUS). Therefore, if a data user is faced with two competing data
points regarding the average time a woman spends on domestic /unpaid care work for
a certain country and year, the preferable data point would be the one that aligns with
ICATUS based on the metadata for such data points.

Comparable: Data should ideally be comparable over time and across space. To compare
data over time, it is important that the definition of a concept is the same over time and
across countries. If the concept has changed or varies across countries, then it must
be explained, typically utilizing a metadata document. For instance, to calculate the
proportion of women living in households utilizing cooking fuels that might be harmful
for their health, traditionally the international statistical community only classified
‘solid fuels’ as unclean, and therefore harmful. In recent years, however, fuels like liquid
kerosene have been reclassified into the ‘unclean’ category. Estimates of disability in

1 See UNSD https://unstats.un.org/unsd/unsystem/documents/UNSQAF-2018.pdf
2 IFAD Data Governance Policy (2022). EB-2022-137-R-8.pdf (ifad.org)
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Uganda have changed from asking if a person has a disability to asking about their
level of functioning in specific domains. Therefore, revised statistical definitions and
calculations reflect this change. To ensure the current estimates for women living
in households using unclean cooking fuels are comparable with those produced in
previous years, statisticians might recalculate old estimates or might include a note in
the indicator metadata. It is important that data users read metadata carefully to assess
whether comparisons over time and space are possible and whether methodology and
definitions have been consistent.

Accurate: The accuracy of a statistical output is measured in terms of how correctly it
estimates or describes the quantities or characteristics they are designed to measure. It
is the closeness between the values provided and the true values. Assessing accuracy
might require different measures, depending on the type of data-collection instrument.

In the case of survey data, major sources of error are coverage, sampling, non-response,
and processing errors in addition to biased responses. For example, interviewing the
household head (generally the male) about women's lives in that household might yield
inaccurate results.

Due to inconsistencies in definitions, classifications and administrative concepts,
statistical products from administrative sources may be erroneous. In addition, there
is need to use multiple sources of data to complement each other as one may not
reflect the true story. For example administrative data may have underreported data
on violence and crime incidents since some women may not report cases of GBV for
various reasons. Survey data and data from expert assessments can therefore be used
to complement this data during analysis. Information on data sources can also be
gathered from metadata files.

Reliable: It is the closeness of the initially released values of a statistical output to the
values that are subsequently released for the same reference period. The closer the
two sets of values are, the more reliable the data is. For instance, a data user might
wish to know about whether school enroliment has increased or decreased in the last
year in Uganda. A review of the school census data might give quick impressions of the
changes being observed.

Timely/ punctual: It is the length of time between the availability of data and the
phenomenon it describes. Timeliness is assessed in terms of a time scale that depends
upon the period for which the data are of value, i.e., are sufficiently timely to be acted
upon. For instance, the timeliness of labour market indicators might be different from
that of violence indicators. School enrolment data should be available quickly, for
example to inform allocation of school capitation grants. Violence patterns tend to
change slowly, two-year-old violence data might still be considered timely for decision-
making.

Accessible: The physical conditions in which users can obtain data: where to go, how
to order, delivery time, clear pricing policy, convenient marketing conditions (copyright,
etc.), availability of micro or macro data, various formats (paper, files, CD-ROM,
Internet...), etc. The data produced should be readily accessible by users. Depending on
the type of user (statisticians, policymakers, researchers, journalists, NGOs, academics,
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etc.), multiple dissemination and communication formats should be used by the data
production agency.

Depending on the data producer and the type of data, gender data might exist but
may not always be readily accessible in online databases and reports. Data users are
encouraged to reach out to producers to request sex-disaggregated estimates in cases
when these aren't readily available online.

Interpretable/ clear: It is the ease with which users can understand and properly use the
data. Metadata, which is a document comprising definitions, key concepts, coverage,
etc., plays a major role in making data interpretable by users. It is important to read the
metadata before using gender data.

Summary of the Data Quality Criteria

Table 2: Summary of the Data Quality Criteria
Quality Aspect Description

Relevant Data relevance ensures that statistical products meet user
needs by producing necessary statistics and using concepts
that reflect user requirements.

Coherent Coherence means that statistical outputs are logically
connected and consistent with established concepts,
definitions, and classifications.

Comparable Data comparability ensures that statistics can be compared
over time and across regions by maintaining consistent
definitions and methodologies.

Accurate Accuracy refers to how closely statistical outputs estimate or
describe the quantities they are intended to measure.

Reliable Data reliability reflects consistency between initially released
and subsequent values forthe samereference period, indicating
dependable statistical outputs.

Timely/Punctual Timeliness measures how quickly data becomes available
relative to their relevance for decision-making.

Accessible Accessibility ensures that users can obtain data easily through
various formats and channels.
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Interpretable/Clear  Data interpretability hinges on metadata clarity, providing
definitions, coverage details, and key concepts that aid users
in understanding and utilizing the data effectively

MODULE TWO

EMBEDDING GENDER STATISTICS IN DECISION-MAKING 35
A Facilitator Guide for Training of Users of Gender Statistics in Uganda




S Exercise 2.2: Indicators of data quality
E 1. What does “accuracy” refer to in the context of data quality?
a) The extent to which data is free from errors or mistakes
b) The relevance of the data to the research question

c) The consistency of the data over time

d) The ability to access the data easily

2. Which of the following is an indicator of data completeness?
a) Consistency of data values
b) Timeliness of data collection
c) Presence of missing or incomplete records

d) Accuracy of data entry

3. What does “timeliness” indicate about data quality?
a) The degree to which data is relevant to current circumstances
b) The extent to which data is consistent across different sources
¢) The accuracy of data compared to a known standard

d) The speed at which data is collected and processed

4. Which of the following is NOT an indicator of data consistency?
a) Uniformity of data formats and structures
b) Absence of outliers or anomalies in the data
c) Agreement between different data sources or versions

d) Stability of data values over time

5. Why is “relevance” an important indicator of data quality?
a) It ensures that data is collected from a representative sample
b) It allows for comparisons between different datasets
c) It ensures that data meets the specific needs of the intended users

d) It facilitates data sharing and collaboration between organizations

6. Which of the following is an indicator of data reliability?
a) The availability of metadata describing the data source and collection methods

b) The degree of agreement between independent measurements or observations
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10.

The ability to trace data back to its original source or origin

The absence of systematic bias or distortion in the data

What does “validity” refer to in the context of data quality?
The consistency of data values over time

The extent to which data accurately represents the concept or phenomenon it
intends to measure

The availability of additional information or context about the data

The ease with which data can be accessed and retrieved

Which of the following is NOT an indicator of data accessibility?

Availability of data in multiple formats or languages

Ease of data retrieval through standardized queries or interfaces

The extent to which data is protected from unauthorized access or modification

Consistency of data values across different sources or versions

What does “integrity” refer to in the context of data quality?

The degree to which data is consistent with a known standard or benchmark
The ability to ensure the security and privacy of sensitive data

The prevention of unauthorized access, alteration, or deletion of data

The accuracy and reliability of data values over time

Why is it important to consider “auditability” as an indicator of data quality?
It allows tracking changes made to the data over time

It ensures that data is collected from a diverse and representative sample

It facilitates data integration and interoperability between different systems

It helps ensure compliance with legal and regulatory requirements
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Answers to Exercise 2.2: Indicators of data quality

1. What does “accuracy” refer to in the context of data quality?
a) The extent to which data is free from errors or mistakes v
b) The relevance of the data to the research question
c) The consistency of the data over time

d) The ability to access the data easily

2. Which of the following is an indicator of data completeness?
a) Consistency of data values
b) Timeliness of data collection
c) Presence of missing or incomplete records v

d) Accuracy of data entry

3. What does “timeliness” indicate about data quality?
a) The degree to which data is relevant to current circumstances
b) The extent to which data is consistent across different sources
¢) The accuracy of data compared to a known standard

d) The speed at which data is collected and processed v

4. Which of the following is NOT an indicator of data consistency?
a) Uniformity of data formats and structures
b) Absence of outliers or anomalies in the data v
c) Agreement between different data sources or versions

d) Stability of data values over time

5. Why is “relevance” an important indicator of data quality?
a) It ensures that data is collected from a representative sample
b) It allows for comparisons between different datasets
c) It ensures that data meets the specific needs of the intended users v/

d) It facilitates data sharing and collaboration between organizations

6. Which of the following is an indicator of data reliability?
a) The availability of metadata describing the data source and collection methods

b) The degree of agreement between independent measurements or observations
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10.

The ability to trace data back to its original source or origin

The absence of systematic bias or distortion in the data

What does “validity” refer to in the context of data quality?
The consistency of data values over time

The extent to which data accurately represents the concept or phenomenon it
intends to measure

The availability of additional information or context about the data

The ease with which data can be accessed and retrieved

Which of the following is NOT an indicator of data accessibility?

Availability of data in multiple formats or languages

Ease of data retrieval through standardized queries or interfaces v

The extent to which data is protected from unauthorized access or modification

Consistency of data values across different sources or versions

What does “integrity” refer to in the context of data quality?

The degree to which data is consistent with a known standard or benchmark
The ability to ensure the security and privacy of sensitive data

The prevention of unauthorized access, alteration, or deletion of data v

The accuracy and reliability of data values over time

Why is it important to consider “auditability” as an indicator of data quality?
It allows for tracking changes made to the data over time v/

It ensures that data is collected from a diverse and representative sample

It facilitates data integration and interoperability between different systems

It helps ensure compliance with legal and regulatory requirements
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SESSION 2.3: EXTRACTING GENDER STATISTICS FROM FULLY PROCESSED
MACRODATA

Session objective: Enable participants to understand how to access and review reports
to extract gender statistics

Methods: A facilitator's presentation, demonstration, and take-home
assignment.

Requirements: Computers, internet access, printouts of a report extract

Preparation: a). Before the session, the facilitator shoud

b). Prepare a printout of the steps for accessing and retrieving
gender data from reports. Prepare printouts of a report
extract or electronic copies to be provided to participants.

Duration 180 minutes
Activity 2.3: Identifying and Extracting Gender Statistics from a Report

Notes/Handouts 2.3: How to access and use Macrodata

Activity 2.3: Identifying and Extracting Gender Statistics from a Report

i. Introduce the session by explaining the recommended steps for accessing and
reviewing reports for gender statistics (Refer to Notes 2.3).

il. Using a report, demonstrate how you would typically apply the steps presented.

iii. Administer Exercise 2.3.

i

Notes/ Handout 2.3: How to access and use Macrodata

Various United Nations documents guide the process of accessing macrodata/
gender statistics from reports. These include Budlender, D. (2015), United
Nations Economic Commission for Europe (UNECE), (2010), and United Nations
Statistics Division (UNSD), (2015). The steps include:

a) Based on your knowledge of the available resources, identify the most probable
source.

b) For both printed and digital/digitised versions of reports, you can browse
through the Table of Contents and the Executive Summary to identify the topic
or subtopic that might have the gender statistic of interest.

c) To search for gender-specific findings, scan the main body of the report for
gender-specific findings, results, or analysis. Look for sections, subsections, or
paragraphs that discuss gender-related topics. For digitized versions of reports,
you can conduct a word search. You may try alternative words before accessing
the right gender statistics in the report. Look for keywords or sections related to
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d)

9)

h)

gender, women, men, or gender-specific issues.

Check data tables, charts, graphs, or figures that present gender statistics or
disaggregated data by gender. These visual representations can provide a quick
overview of gender patterns, differences, or distributions in the research findings.

Consider cross-references and citations, and footnotes, within the report that may
lead to additional sources of gender statistics, related studies, or data sources for
further exploration.

Examine appendices or supplementary materials that may contain additional
gender statistics, datasets, or detailed analysis not included in the main text.

Evaluate the quality, reliability, and interpretation of the gender statistics presented
in the research report. Consider factors such as sample size, representativeness,
data collection methods, measurement tools, and potential biases.

Document the gender statistics extracted from the research report, along with
proper citations and references to comply with research integrity standards.
Although there is no agreed citation style for Government of Uganda, some
agencies use the APA (put in full) citation style.

Report

E Exercise 2.3: How to Identify and Extract Gender Statistics from a

Steps

Provide copies of the executive summary of the Uganda Police Annual Crime
Report 2021 (Inserted below).
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ii. Ask each group to read the Executive Summary as a take-home assignment.
iii. Ask each participant to identify gender statistics captured in the report extract.
iv. On the following day, allow 3 to 5 members to present their findings in plenary.

v. Wrap up the exercise, highlighting both sex-disaggregated data and gender issues/
topics as covered in the report extract.

Answers to Exercise 2.3: How to Identify and Extract Gender Sta-
tistics from a Report

Summary of Gender Statistics from the Annual Crime and Road Safety
Report 2021

e Domestic Violence: Significantly higher impact on females (80.6% of the 15,980
reported adult victims in 2021).

e Rape: Overwhelmingly affects females (100% of reported victims).

o Sex-Related Offenses: Females are the majority victims (87.5% of total adult
victims).

e Male Adults Arrested with K9 assistance were: 7,614 (93.4% of adult arrests) and
448 male Juveniles (85% of juvenile arrests)

These statistics highlight the persistent gender disparities in crime victimization, with
females being disproportionately affected by domestic violence, rape, and sex-related
offenses. There are various crimes and road safety issues for which data was not sex-
disaggregated, such as defilement, child neglect, child-related offences, trafficking in
persons, assault, homicide, and road traffic casualties.

The perpetrators of the various crimes are also not indicated. However,

e Men are more frequently both perpetrators and victims of assaults, homicides,
and robberies.

e Men are more likely to be victims of specific theft like motorcycles and mobile
phones impacts men more as owners.

e Men are more often involved in narcotic-related offences, both as offenders and
victims.
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SESSION 2.4: ANALYSING PRE-PROCESSED DATASETS FOR GENDER STATIS-

TICS

Session objective: Enable participants to understand how to access and review
datasets to extract gender statistics

Methods: A facilitator's presentation, demonstration, and group work

Requirements: Computers and internet access for facilitators and participants.

Preparation: The facilitator should confirm the availability of the online
repositories by testing the links in this manual

Duration 180 minutes

Activity 2.4 Obtaining estimates for SDG Indicator from the SDG Global
Database

Notes/Handouts 2.4: Analysing Pre-processed datasets for Gender Statistics

Activity 2.4: Activity on Obtaining estimates for SDG Indicator from the SDG

Global Database

Steps

i. Introduce the session by informing the participants about the availability of the
SDG Global Database. Inform them that this database provides gender statistics
for the SDG indicators.

ii. Using the Notes (Handout 2.4), demonstrate how you would typically apply the
steps presented.

Note: At the time of developing this manual, attempts to generate pivot tables from the data
downloaded from the portal were not possible. Thus, users are encouraged to construct bar
charts and graphs using the usual Excel visualization process

Notes/ Handout 2.4: Analysing Pre-processed datasets for Gender
g Statistics

As already covered in Module One, there are both macro and micro data
databases at both national and global level. Then, we have Database of Databases
(DoD). Data producers who coordinate data dissemination from different sources (such
as UBOS) can benefit from hosting a Database of Databases (DoD). In other words,
centralizing existing databases in an organized manner can help users access the most
relevant data whenever they wish, for a given project. An example of a DoD is Eurostat'’s’
list of databases by thematic areas. When each theme is expanded, a list of sub-themes
and relevant databases appears. As databases are live platforms, i.e. they are regularly
updated, changes to URLs must be monitored to ensure the DoD remains up to date.

1 https://ec.europa.eu/eurostat/data/database?p p id=NavTreeportletprod WAR NavTreeportletprod INSTANCE nPgeVb-
PXRmWQ&p p_lifecycle=0&p p_state=normal&p p mode=view&p p col id=column-2&p p col pos=1&p p col count=2
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General comments on the international data databases

e The data available does not cover all the spheres and indicators of women and
men's lives. There are large gaps in gender data because:

o Recent data has not been uploaded because they have not been provided by
UBOS.

o The government has not invested enough in collecting gender statistics.
o Data onissues facing women and girls are not collected frequently.
o Thereis a gap in collecting data on new and emerging issues.

o The information available from various sources is not mutually exclusive.

UN Women's data portal (https://data.unwomen.org/data-portal)

UN Women's ‘Women Count Data Hub’ provides free access to gender data that can be
used to monitor progress on the SDGs and other gender indicators. The Women Count
Data Hub brings together gender data, stories, and analysis about the lives of women
and girls.

Once on the website, you follow the steps below:

i. Select “Data” feature on the top right corner of the homepage.

SLIM 2 WML ; ; %
wer s | VR Giti1e  WDReS WBOUBCEL (WA SOMSMCODS|  MOSY  CAUIMBSS N o

SDG Indicator Dashboard

root

ii. Select the group of indicators of interest? such as “SDG Indicators” from the list.
SDG Indicator Dashboard

2 How to use the dashboards | UN Women Data Hub can help a user navigate through the data.
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iii. Pick your preferred form of visualization from the icons on the left - you have
many choices! map, line graph, bar graph, or table. If the visualisation icon is
invisible, reduce the page zoom by clicking Ctrl and — buttons at the same time.

~ E B

iv. Select the goal and indicator(s) to measure. In this case, Goal 5, indicator
5.5.1 and series, proportion of seats held by women held women in national
parliaments (% of total number of seats). Then choose ‘Done’

Goal
fff

Indicator

Proportion of scats held by women 1.

In Deliberalive Bodies -
Of Local Governmant

(%)

Proportion Of Seals
Hald By Women In
Matienal Parliamonts (%
Ol Total Mumbar Of

Seatls)

Musswsbugnr 3 Suaevin bl

v. Select the parameters i.e. geographical area(s), year(s) and compare by sex. You
can optionally select years or latest available data point. Countries are listed
under regions — Uganda is listed under Eastern Africa.

SDG Indicator Dashboard

L]

Canl
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vi. Download the data output in the preferred format (pdf or csv) by clicking the icon
at the bottom right corner of the computer screen.

Some examples of the levels of presentation of data that can be downloaded from
the Women Count Data Hub include:

e Regional aggregates for any of the world’s regions (according to SDG regional
groupings) for any SDG indicator, provided data availability is sufficient to
allow for reliable aggregations.

¢ National estimates for any number of countries and relevant years. The user
can either select specific years, a certain period, or the latest available data
point.
Once a user has found the desired data in UN Women's data hub, relevant metadata to
assess the quality of the data can be found by selecting the (i) information icon at the
bottom right corner of the screen to explore the relevant metadata.

Comment on UN Women Data portal: The strength of this portal is the easy navigation and
the opportunity to retrieve data for a specific year or the latest available year. However, one
cannot compare values for different years.

Macrodata data from the Global SDG database (https://unstats.un.org/sdgs/indicators/
database/)

The Global SDG Indicators Database is a data dissemination platform that provides
access to data compiled through the UN system to monitor the SDGs. It allows users to
study data for the SDG indicators, over time and across regions and countries.

To demonstrate the steps involved in conducting gender analysis utilizing this data,
let's suppose the research question is: How much time do women and men spend on
unpaid domestic chores and care work in Uganda?

To undertake the analysis, follow these steps:
Step 1: Log onto the Global SDG Indicators Database

Once the user opens the database site, it will be important to select the right indicator
and series, the desired country or region, the year of interest.

Step 2: Select the data series
Click the active bar with the words, ‘Select indicators, and countries, areas or regions’

Select the Goal of interest, in this case Goal 5 (Gender equality) by clicking the before
the text. Then, click ‘Show Results’ at the bottom of the screen.
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Indicators Countries, areas or regions
(Selected 47 of 692 series) [Selected 266 of 266)

All Search
L] GOAL 1 End poverty In all its forms everywherg
[ GOAL 2 End hunger, achieve food securnily and improved nuintion and promote sustainable

agricufture
[ GOAL 3 Enaure healthy lives and promote wel-being for all at all ages

. GOAL 4 Ensure Inclusive and equitable quality education and promote lifelong leaming
opportunities for all

[ GOAL 5 Achieve gender equality and empower all women and girls

" GOAL & Ensure availability and sustainable management of water and sanitation for all

" GOAL 7 Ensure access 1o affordable, reliable, sustainable and modermn energy for all

3 GOAL 8 Promote sustained, inclusive and sustainable sconomic growl h, full and productive

employment and decent work for all

L GOAL 9 Build resilient infrastructure, promaote inclusive and sustainable industrialization and

foster innovation

[ GOAL 10 Reduce inequality within and among countries

J GOAL 11 Make cities and human settlerments inclusive, safe, resilient and sustainable

L GOAL 12 Ensure sustaimable consumption and production pattems

® GOAL 13 Take urgent action 10 combat climate change and s impacts

3 GOAL 14 Conserve and sustainably use the oceans, s&as and marine resources for sustainable

developrment

. AAAL 16 Brndant rantnrs nnd pesemain sseetainahkin en af fammantrial snmnretaman i bmabde

pe ~
e )

Under the Data Series tool bar, click the (x) symbol on the extreme right to remove all
the indicators populated on the tool bar. Then, place the mouse on the Data Series tool
bar and scroll to the drop-down list to select your indicator of interest. You can choose
multiple indicators, one at a time. Or type the indicator(s) of interest, which in our case
is 5.5.1 in the Data Series tool bar. This picks indicator 5.5.5 i.e. Proportion of seats held
by women in a) national parliaments and b) local governments (%). Each indicator name
is displayed once you hover the mouse over the indicator number.

Data Series (Seleched 47 ol 092

511 5.1 531 G532« 341 BESA 352 L3R | S62 .« +4
T Balect
Comvirkes, arnas or regloms (Seleciosd 0 of 204)

T CountTess oF Aees

Vield (tortal) by 5006 reglons Winrid ftotaf) by contimental regians v
By deladll AN a8 Selected
= Solect
Pesiod Hargsl Vo (25 e 25
2000 2001 2002 2003 = 02 2005 2006 2007 2008
=6
Yoo Enr st ct, g yeht of muiliple jears

19,502 ohaervations
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Step 3: Select the country of interest - For this example, select Uganda

Click ‘countries or areas.” Under the ‘Countries, areas or regions’ tool bar, click the (x)
symbol on the extreme right to remove all the entries on the tool bar. Then, place the
mouse on the Countries, areas or regions’ tool bar and scroll to the drop-down list to
select your country of interest. You can choose multiple countries, one at a time. Or type
the country of interest, which in our case is Uganda.

Step 4: Select the period

Under period, choose Range if interested in statistics for a specific period/ range of
years (e.g. 2017-2024). In this case, you choose the start and end of the year in the next
step from the calendar that pops up. If interested in selected years, choose Years. Here,
you can choose several years of interest, one after another. Then click, ‘Show Results’

In the Global SDG Indicators Database, more than 200 indicators can be found under a “tree”
structure that mirrors the structure of the SDG monitoring framework. That is, there are
17 goals, each of which is divided into several targets, and there are several indicators to
monitor progress against each target

Step 4: Select the download option

Click on the ‘download’ button to view the results on an Excel sheet. This option is
preferable to just viewing the table if you wish to further analyse the data, create
graphs, or run pivot tables. After downloading, a data file will open in two sheets — Code
Descriptions (metadata) and the Goal.

Step 5: Create a pivot table®

Select ‘Insert’ and then ‘PivotTable’, which can be found on the top left-hand side of the
Excel sheet. A pivot table is a data summary tool used for data processing. Pivot tables
are used to summarize, sort, reorganize, group, count, total or average data stored in a
database. They also allow users to transpose information; that is, transform columns
into rows and rows into columns.

Figure 6: Icon for Pivot Table

File Home Insert P

ish &

PivotTable Recommended Table
PivotTables

Tables

After inserting a ‘Pivot table’, a new dialogue box appears, as follows. This box allows
the user to decide whether the new table should be inserted in the existing worksheet
or in a new sheet. Make your selection and click OK. It is recommended to choose ‘New
Worksheet’

3 See https://www.kohezion.com/blog/what-is-a-pivot-table-examples-and-uses
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Figure 7: Dialogue box with additional options

Create PivotTable ? X

Choose the data that you want to analyze

(O select a table or range

1

Table/Range:
i:l Use an external data source
Choose Connection...

Connection name
@l Use this workbook's Data Model

Choose where you want the PivotTable report to be placed

() New Waorksheet

>

Location: | 'data (2)'1SWS12

Choose whether you want to analyze multiple tables

Add this data to the Data Model

Cancel
Step 6: Customise the data on the Pivot Table

A new table has now been created, and a new dialogue box appears containing the Pivot
Table’s fields. Depending on the table the user wants to create, the various fields can be
dragged and dropped into filters, columns, rows, and values. To calculate the proportion
of time that men and women spend on unpaid care and domestic work in urban and
rural areas, drag and drop the fields as follows:

o Drag ‘SeriesDescription’ to ‘Filters’
o Drag ‘Value' to ‘Sum of Values'

Figure 8: Pivot table fields to create customized table

PivetTable Fields

HEb -
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Step 7: Create a ‘pivot chart’ for graphical representation of this data

To create a graphical representation of the data, select the data with your mouse, and
click on insert ‘PivotChart'.

Figure 9: Dialogue box showing Pivot chart options

PivotChart Recommended
PivotTables

Tools

A list of charts will appear, and the user can choose the type that suits the data best. For
more information on how to choose the right chart for your data, refer to Module Five on
Visualising gender statistics. For this example, choose the simple ‘column’ chart option.

Step 8: Format the Pivot Chart 7&8 are the same

Step 7: Format the Pivet Chart:

AutoSave
Select “Add Chart Element’ .
File Home
Add ‘Chart’ title | i
Add data labels l I ! 3— E
Data Legends + ;
Vertical axis (express in %) Add Chart  Quick

Element ¥ Layout ¥

Chart Layouts

UBOS Gender Data Portal (Gender Statistics Portal (ubos.org)

The Gender Statistcis Portal under the Uganda Bureau of Statistcis is a one stop center
for Gender Statistical Data for Uganda.

UBOS Gender Based Violence Incidence Dashboard (Gender Based Violence Incidence

Dashboard - till 2021 (ubos.org)

The UBOS Gender Based Violence Incidence Dashboard provides detailed information on
the incidence rates, types, demographics, and geographical distribution of gender-based
violence (GBV) in Uganda. The dashboard aggregates data from police (2012-2017) and
MOH (2018-2019) records and reports. This resource helps visualize and analyze the
prevalence and characteristics of GBV across different regions and demographics.

UBOS National Statistics Office Open DataPortal (https://nso-uganda.opendataforafrica.
org/)

TheUBOS National Statistics Office Open DataPortal provides acomprehensive collection
of data on various socioeconomic topics in Uganda. The portal includes information on
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demographics, economy, health, education, environment, and infrastructure. It offers
datasets, predefined dashboards, and visualizations. Data on some specific indicators

are covered https://nso-uganda.opendataforafrica.org/data/#topic=Gender in addition

to gender data embedded in other topics.

UBOS UgStats mobile app

According to UBOS (https://www.ubos.org/data-portals-2/ugstats-mobile-app/), The

UBOS UgStats mobile app provides access to over 100 frequently requested statistics
from various categories, including population, prices, labour, agriculture, education,
trade, and GDP. The data are updated regularly, and users receive notifications for
updates on their preferred indicators. The app displays data in tables and bar charts,
which can be shared on social media, and allows toggling between different formats. It
covers a five-year period and provides links to more data on the UBOS website. The app
is available for free on Android devices.

World Bank DataBank (Data | DataBank (worldbank.org))

The World Bank's DataBank provides a comprehensive collection of time series data on
global development indicators, covering topics such as economics, health, education,
and the environment. It includes access to over 20 databases, including gender statistics
on key themes such as demographics, education, health, labor force, and political
participation. Users can create customized reports, visualize data through charts and
graphs, and download datasets in various formats.

OECD Statistics Portal (https://data-explorer.oecd.org/)

includes data and metadata for OECD countries and selected non-member economies,
including Uganda. It covers topics such as agriculture and fisheries; development;
economy; education and skills; environment and climate change; finance and investment;
public governance; health; industry, business and entrepreneurship; science, technology
and innovation; employment; society; regional, rural and urban development; trade;
transport; and taxation,

UBOS Sustainable Development Goals Data Portal (https://uganda.opendataforafrica.
org/addin/sdqg)

The UBOS Sustainable Development Goals (SDG) Data Portal provides a comprehensive
overview of Uganda’s progress towards achieving the SDGs. The portal includes time
series data and metadata on various indicators across all 17 SDGs, covering areas such
as poverty reduction, education, gender equality, and economic growth.

2.4:  Exercise on Computing median age from DHS STATcompiler

Using pre-processed data from DHS STATcompiler, obtain the estimates for median
years of education completed in Uganda by women and men in the years 1995-2019.

Step 1: Go to DHS STATcompiler https://www.statcompiler.com/en/

Step 2: Select Uganda from the list of countries
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Step 3: Select ‘Median years of schooling completed’ for both men and women (selected
separately from the comprehensive list of indicators).

Median years of education Median years of education completed [Men] B
compheted [Women] O

Conniry Sy Tatal 15-49 Todal Tl 1549

Step 4: Export the table in ‘Table Format'.

Median years of ec Median years of ec

Country Survey Total 15-49 Total Total 15-49
Uganda 2018-19 MIS 5.9

Uganda 2016 DHS 5.7 6.3 6.3
Uganda 2014-15 MIS 5.6

Uganda 2011 AIS 5 6.1 6.1
Uganda 2011 DHS 5.2 5.7 5.8
Uganda 2009 MIS 5.1

Uganda 2006 DHS 4.4 5.5 5.5
Uganda 2004-05 AIS 3.9 5.6 5.6
Uganda 2000-01 DHS 3.9 5.5 5.6
Uganda 1995 DHS 3 5.1 5.1

Median years of ec Median number of years of education completed by men
Median years of ec Median number of years of education completed by women
ICF, 2015. The DHS Program STATcompiler. Funded by USAID. http://www.statcompiler.com. May 19 2024

Step 5: Clean the data by deleting rows or columns with missing data (in this case none)

a) Rename column C as ‘Women’, column E as ‘Men’ and column F as ‘Overall’

Step 6: Visualize the data and format the chart:
a) Choose a line graph because we want to show change over time.

b) Arrange the data in ascending order to see the change since 1995.
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Figure 10: Line graph showing mean years of education completed by women in Uganda

Means of education completed by women in
ganda, 1995-2019

1905 2000- 2004- 2008 2009 2011 2011 2014 2016 2018-
DHS 01 DHSO5AIS DHS MIS AlS DHS 15MIS. DHE 18MIS

Note: We have inserted a line graph for women only as some sources lacked statistics for
men.
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ANALYSING
SELECTED MICRO
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STATISTICS



MODULE THREE: ANALYSING SELECTED
MICRO DATA SOURCES FOR GENDER
STATISTICS

©

@

LEARNING OUTCOMES/OBJECTIVES

After completing this Module, the learner is expected to have understood

How to access the available interactive data portals and how they can
conduct basic gender data analysis and visualization

Interpret statistical outputs related to gender data.

OVERVIEW OF THE MODULE

This module will cover the key concepts of macrodata and microdata,
highlighting their differences and applications in statistical analysis.
Participants will explore national and international data sources, including
UBOS and DHS STATcompiler, and learn when to use macrodata versus
microdata for research and decision-making. The session will provide a step-
by-step guide on accessing and analyzing data using DHS STATcompiler,
including selecting indicators, disaggregating data, and exporting results. The
session will conclude with key takeaways on leveraging data for evidence-
based policymaking and research.

NOTE TO FACILITATOR

Microdata is essential for calculating gender indicators and specific
estimates for smaller, targeted population groups. The DHS STATcompiler
is a valuable tool for accessing pre-processed microdata and summary
statistics, allowing users to explore demographic and health indicators
without conducting complex statistical analysis. Users can select specific
countries, indicators, and disaggregation variables such as residence (urban/
rural) and wealth quintile to generate relevant estimates. However, if users
require a more specific combination of variables, they will need to access
and analyze the DHS microdata directly. The STATcompiler simplifies the
process of retrieving pre-processed statistics but has limitations when it
comes to highly customized analyses.

To utilize DHS STATcompiler, users should follow a simple step-by-
step process: selecting the country and indicator of interest, applying
disaggregation variables, and visualizing data through available graphing
tools. The platform also allows users to export data in multiple formats for
further analysis orreporting. Beyond DHS STATcompiler, additional microdata
sets for Uganda can be accessed through international organizations such
as the International Labour Organization (ILO) for National Labour Force
Survey data and the Uganda National Panel Survey (UNPS).
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C: TIME:
$  11HOURS

SESSION 3.1: DATA ANALYSIS USING THE DHS (DEMOGRAPHIC AND HEALTH

SURVEYS) STATCOMPILER

Session objective:

Methods:

Requirements:

Preparation:

Duration
Activity

Notes/Handouts

Enable participants understand how to access DHS STATcompiler
and how they can conduct basic gender data analysis and
visualization

A facilitator's presentation, demonstration, and individual
exercise

A projector, a computer, and internet access for the facilitator &
participants

Before the session, the facilitator should;

a) confirm the availability of the online repositories by
testing the links in this manual.

b) Inform each participant to carry a computer to the
workshop room.

60 minutes
3.1: Activity on Sources of Micro Datasets

3.1A: Sources of Micro Datasets

3.1B: DHS (Demographic and Health Surveys) STATcompiler

3.1: Activity on Sources of Micro Datasets

o Divide participants into small groups.

o Assign each group a specific theme (e.g., health, labor force, education, poverty,

gender).

o Ask each group to list potential sources of microdata for their theme, considering
both national and international sources.

o Each group will use available resources (internet access, provided handouts, or
prior knowledge) to identify where relevant microdata can be accessed.

o Each group will present their findings in 5 minutes.

o Facilitator will summarize key points, clarify differences between sources, and
discuss challenges in accessing microdata.
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ﬂ Notes/ Handout 3.1A: Sources of Micro Datasets

Most countries analyse and process their microdata to obtain national

aggregates or microdata estimates. However, microdata can be useful for
users to conduct further analysis, including assessing how strongly two different
variables are associated through correlations or regressions. Microdata is also useful
for modelling and forecasting. Finally, working with microdata is also key to calculate
gender indicators for specific population groups. As most macrodata published is
representative of a whole country, or large population groups within the country (e.g.
men and women; urban and rural areas, etc.), microdata might be necessary to calculate
estimates for specific population groups (e.g. women living in the poorest households
of rural areas).
Examples of repositories of microdata that can be accessed free of charge, among
many others, include:

o DHS STATcompiler: https://statcompiler.com/en/
. DHS datasets: https://www.dhsprogram.com/data/available-datasets.cfm
. MICS datasets: http://mics.unicef.org/surveys

These are databases based on microdata (e.g. survey or census data) but where some
basic calculations have already been completed by developers. As opposed to microdata
repositories, micro-databases have survey, and census estimates ready to use. Thus,
the user can make selections — pertaining to population groups, age groups, variables,
etc. — and cross-tabulate information as desired, without utilizing statistical software.

One such example is DHS STATcompiler, a tool that allows users to build custom tables,
charts and maps from thousands of indicators extracted from Demographic and Health
Surveys (DHS) across 90 countries'.

1 https://www.statcompiler.com/en/

STATcompiler (https://statcompiler.com/en/)

9 Notes/ Handout 3.1B: DHS (Demographic and Health Surveys)

DHS STATcompiler provides access to pre-processed microdata and simple
summary statistics. This means that the user can specify the population groups and
indicators of interest, and the specific aggregates for those combinations will be
displayed for download, so the user does not need to conduct actual statistical analysis
from the microdata itself.

For instance, if a data user would want to see the proportion of deliveries in health
facilities in Uganda for the year 2018, in both urban and rural areas, as well as in the
poorest and richest households, DHS STATcompiler provides flexibility for the user
to select these disaggregation variables and download relevant estimates for these
groups.

However, if the user wants to examine what this indicator would look like for the poorest
women living in rural areas (a combination of the two disaggregation variables utilized
above), this information is not pre-processed in STATcompiler, so the use of the DHS
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microdata itself will be necessary.
e Step 1: Go to the DHS STATcompiler website (https://statcompiler.com/en/)

On the first page of the website, two options are possible: CHOOSE COUNTRY and
CHOOSE INDICATOR.

e Step 2: Select the country and indicator of your choice.
e Step 3: Click NEXT

e Step 4: Disaggregate the data by variables of your choice (residence, age group,
geographical area, wealth quintile etc.)

e Step 5: To visualize this data, select the graph option on the top left of the DHS
website screen.

e Step 6: Export the data table or graph by selecting ‘Export’ and the desired
format.

Other datasets

Microdata sets for Uganda are also housed at websites of international organisations,
such as websites of the International Labour Organisation (ILO) for National Labour
Force Survey and the Uganda National Panel survey (UNPS).

SESSION 3.2: DATA ANALYSIS USING MICRODATA FROM THE DEMOGRAPHIC

AND HEALTH SURVEYS

Session objective: Enable participants understand how to access DHS microdata
and how they can conduct basic gender data analysis and
visualization

Methods: A facilitator's presentation, demonstration, and individual
exercise.

Requirements: A projector, a computer, and internet access for the facilitator

& participants.

Preparation: Before the session, the facilitator should:

a) Confirm the availability of the online repositories by
testing the links in this manual.

b) Inform each participant to carry a computer to the
workshop room.

Duration 60 minutes

Activity 3.2: Analysing Microdata from the Demographic and Health
Surveys

Notes/Handouts 3.2: Microdata from the Demographic and Health Surveys
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Activity 3.2: Activity on Analysing Microdata from the Demographic and Health

Surveys

i. Introduce the session by informing the participants about the availability of
Microdata from Demographic and Health Surveys. Inform them that this database
provides gender statistics.

ii. Using the Notes (Handout 3.2), demonstrate how you would typically apply the
steps presented.

Surveys (https://dhsprogram.com/)

ﬂ Notes/ Handout 3.2: Microdata from the Demographic and Health

Steps for Accessing Microdata from the DHS Program

1. Register and Request Access: First, you need to register for an account on the
DHS Program website (https://dhsprogram.com/) and request access to the
datasets. Depending on your purpose and affiliation, you may need to provide
additional information to gain access.

2. Browse Datasets: Once you have access, you can browse the available datasets
on the DHS Program website. Navigate to the “Surveys” section and select the
country or countries you are interested in. Then, choose the specific survey(s)
you want to explore.

3. Review Documentation: Before downloading microdata, it's essential to
review the survey documentation provided on the DHS website. This includes
information about the survey methodology, sampling design, questionnaire
content, and variable definitions.

4. Download Data Files: After selecting the desired survey(s), you can proceed to
download the microdata files. The DHS Program offers various data formats,
including flat files (e.g., ASCIl or CSV), SPSS, Stata, and SAS formats. Choose the
format that is compatible with your statistical software.

5. Extract and Explore Microdata: Once you've downloaded the data files, extract
them to your local machine and import them into your statistical software (e.g.,
SPSS, Stata, or R). The microdata files typically include information on individual
survey respondents, with each row representing a respondent and columns
representing variables.

6. Analyse and Export: You can now analyse the microdata using statistical
techniques appropriate for your research questions. Depending on your analysis
needs, you may conduct descriptive analyses, correlation analyses, or regression
analyses. After analysing the data, you can export the results in various formats
for further reporting or visualization.

7. Follow Terms of Use: It's crucial to adhere to the terms of use and data sharing
guidelines outlined by the DHS Program. Ensure that you cite the DHS surveys
appropriately in any publications or presentations based on the data.
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To use microdata from the DHS program, one needs:
a) Expertise in using relevant statistical data analysis software e.g. STATA.
b) Statistical data analysis software e.g. STATA installed on a computer,

c) A basic understanding of variables and recode variables: https://dhsprogram.
com/pubs/pdf/DHSG4/Recode7_DHS_10Sep2018_DHSG4.pdf

d) To be familiar with DHS Guide for data analysis: https://dhsprogram.com/data/
Using-Datasets-for-Analysis.cfm

Note -National sources: The UBOS website does not contain microdata. However,
microdata can be requested from UBOS.
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MODULE FOUR: INTEGRATING A GENDER
PERSPECTIVE IN DATA ANALYSIS AND
INTERPRETATION

<

) )

&

LEARNING OUTCOMES/OBJECTIVES

After completing this Module, the learner is expected to have:
a. Understood the types and qualities of gender responsive indicators.

b. Understood some ways of integrating gender across the analysis
process.

c. Inthe context of gender statistics, gained competence in presenting
or interpreting statistical measures

OVERVIEW OF THE MODULE

This module focuses on integrating a gender perspective in data analysis
by using gender-responsive indicators to measure gender disparities and
track progress toward gender equality. It outlines the importance of defining
clear research questions and objectives that focus on gender issues and
explains how to analyze data using both pre-processed and microdata
sources. The module covers various types of gender-responsive indicators
and emphasizes the importance of selecting the right data sources. It also
introduces the process of conducting descriptive and comparative analyses
to identify gender disparities, and interpreting findings in the context of
gender-related theories and socio-cultural factors

— 1 NOTE TO FACILITATOR

Facilitators should emphasize the importance of integrating a gender
perspective throughout data analysis, from defining clear gender-focused
research questions to selecting appropriate gender-responsive indicators. It's
crucialto explainthe different types of indicators, including sex-disaggregated
and gender-specific indicators, and how they help track gender disparities.
Facilitators should guide participants in identifying and accessing relevant
data sources, including pre-processed data and microdata, and help them
conduct both descriptive and comparative analyses to uncover patterns and
trends in gender data. Additionally, facilitators should stress the significance
of interpreting findings and effectively communicating these results to
inform policy decisions that promote gender equality.

TIME:
8 HOURS
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SESSION 4.1: GENDER RESPONSIVE INDICATORS

Session objective: e Understood the types of gender responsive indicators.

e Understood the qualities of gender responsive indicators

Methods: Plenary brainstorming, group work, and a quiz.

Requirements: A projector, a computer, flip chart papers, marker pens, and masking
tape.

Preparation: Prepare printouts of Exercise 4.1 or prepare it as an online quiz.

Duration 120 minutes

Activity 4.1A: Gender Responsive Indicators

4.1B: The Basics of Data Analysis

Notes/Handouts  4.1A: Gender Responsive Indicators
4.1B: Categories and Qualities of Indicators

4.1C: The basics of data analysis

Exercises 4.1: Gender Responsive Indicators
Answers to 4.1: Gender Responsive Indicators
exercises

Activity 4.1A: Gender Responsive Indicators

Steps

i. Divide the participants into groups of 5-8 and ask them to discuss the following
questions:

a. What is an indicator in the context of development?
b. What is a gender responsive or gender sensitive indicator?

c. What are the types or categories of gender responsive or gender sensitive
indicators?

ii. Provide time for each group to present in plenary and to receive feedback from
other group and the facilitator.

iii. Instruct participants to note their comments while each group presents, and to
offer feedback after all presentations.

iv. ConcludetheQ&AguidedbyNotes4.1A.Emphasisethatalthough sexdisaggregated
indicators are the most used, there are other types of gender responsive indicators.

v. To assess participants’ learning, administer Exercise 4.1. Participants can
individually fill-in the answers on prepared sheets or discuss in pairs. Alternatively,
the Exercise can be administered online as a quiz on mentimeter, Google Forms,
survey monkey, or any relevant application.
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Activity 4.1B: The Basics of Data Analysis

i. Ask 3 to 5 participants explain the meaning of data analysis. You can note the
points mentioned on a flip chart.

il. Then, ask a follow-up question on the steps/ phases in quantitative data analysis.

iii. Wrap up the discussion guided by Notes 4.1C. Emphasise the focus of the manual
on retrieving fully processed or partially proceed gender statistics.

ﬂ Notes / Handout 4.1A: Gender Responsive Indicators

According to the United Nations Statistics Division (2015), an indicator is a

measure derived from observed facts, used to reveal relative positions, and in
the context of gender statistics, it captures the different conditions of men and women
in various aspects of life (p. 34). A gender-responsive indicator is defined as an indicator
that measures changes related to gender in a society in a specific period. These
indicators are represented as a single figure or a distribution. Figures can be expressed
in numbers, percentages, rates, or ratios. The use of gender-sensitive indicators can
help us to understand how changes in gender relations enable more effective planning
and delivery of future policies, projects, or programmes. As indicators are closely tied to
specific objectives, the first step in the development of appropriate gender-responsive
indicators is to make sure that the objectives of any study have clearly defined gender-
based goals. These may include measures to improve the status of women in society or
a clear statement on how the programme will benefit women and men equally (OXFAM
GB, 2014).

Gender-sensitive indicators (OXFAM GB, 2014) should be able to:
a) Show the gap between women and men.

b) Measure the various roles, responsibilities, and access to resources of various
members of society.

c) Monitor the progress towards realising gender equality goals.
d) Demands data disaggregated by variables such as sex and age.
e) Enable gender analysis of data.

f) Assist the integration of issues related to gender equality across the various
stages of formulation, implementation, monitoring, and evaluation of a policy,
programme, or project.

g) Show the impact of variations on power relations between women and men.
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Notes/ Handout 4.1B: Categories and Qualities of Indicators

Kabeer (1994) proposed four types or categories of gender responsive
indicators as follows:

Sex disaggregated: The value of the indicator is calculated separately for women
and women, and so allows comparisons to be made between the two groups. It
is the most used category of gender responsive indicators. For example, SDG
Indicator: NPGEI 2.1 Net enrollment rate for; Pre-primary, primary and Secondary
by sex (Reprocessed NPGEI 2018)

Gender specific: Measures conditions or practices concerning either women or
men. For example,

e SDG NPGE Indicator 3.23: Proportion of women (aged 15-49) who make their
own sexual and reproductive health decisions (Reprocessed NPGEI 2018)

e Proportion of women in supported households who reported making joint
decisions with their spouses regarding the use of household income.

¢ Indicator 4.1a: Proportion of seats held by women in national Parliament-%-
(Reprocessed NPGEI 2018)

Implicitly gendered: The indicator makes no explicit reference to gender. However,
if it is interpreted within a broader context, the indicator is of relevance to women
or men. E.g.

Proportion (%) of targeted households using energy-efficient cooking stoves.

Number of reported rape cases prosecuted in courts (victims almost exclusively
women).

. Chosen by women or men: Indicators that reflect differences in men’s and

women'’s preferences and priorities. For example, any indicator identified during
consultations with either women or men.

Qualities of good indicators

A combination of the SMART' and CREAM? criteria lead to the following qualities:

1
2

66

1.

Specific/ clear/ objective — unambiguous, operationally precise, uni-dimensional
and consistent over time

Measurable/ monitorable.

Realistic/ practical —can provide timely and up-to-date data at a reasonable
cost.

Relevant/ useful for decision making — and related to the results of the project
and the period of interest.

Direct/ valid — exhibits readily understandable face validity, accepted by

Specific, measurable, achievable, realistic, and time bound.
Clear, relevant, economical, achievable, and monitorable.
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specialists, supported by a body of technical research.
6. Disaggregated -

7. Attributable — links are clear and significant to the intended results. Would
change happen without the intervention being measured?

8. Time-bound

9. Adequate — as a group to measure the desired results. 2-3 indicators per result.

According to the United Nations Statistics Division (2015), analysing data

involves investigating the behaviour of the data, which may include assessing

trends, exploring associations between variables, or studying similarities and
differences between groups. Analysing gender data can therefore be a complex process
in which individual-level records are processed through statistical software, such as
SPSS or STATA, to assess results from a gender perspective, or it can be a much simpler
process through which macro data for gender relevant indicators is directly downloaded
and comparisons are carried out across countries, between indicators and over time.
Analysis of gender data is, all in all, the process used to obtain data-informed responses
to relevant research questions.

ﬂ Notes/ Handout 4.1C: The basics of data analysis

Generally, the following steps should be followed to perform data analysis:
1. Define Objectives and Research Questions

e Clearly articulate the specific objectives and research questions focusing
on gender issues that the analysis aims to address. Objectives should be
precise and align with the goal of understanding gender disparities in the
context of the available secondary data.

e Accordingto UN Women (2018), defining clear research questions is essential
for guiding the analysis towards relevant gender issues and ensuring that
the data is used effectively to uncover disparities (p. 30).

Examples of research questions include:
o What is the unemployment rate of women in Uganda?
o What factors account for the unemployment rate of women in Uganda?
2. Determine if pre-processed data can be used

Depending on the scope of the research question and complexity of analysis
required, it might be possible to use data that is readily available and already
pre-processed, such as international estimates available on global databases,
national databases, or survey reports. If none of these sources provide the
necessary data, one may need to turn to microdata to conduct customized
analysis.
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Identify and Access Relevant Data Sources

Identify existing data sets or reports that contain gender-disaggregated data and
are relevant to the research questions. Search for secondary data from sources
such as national statistical offices, international organizations, and research
institutions.

As noted by Budlender (2015), it is crucial to identify and access relevant
secondary data sources that provide detailed gender-disaggregated information
to facilitate comprehensive analysis (p. 12).

Evaluate the quality, reliability, and suitability of the data for the intended
analysis. Check for data completeness, accuracy, and relevance to the specific
gender-related questions.

According to the United Nations Statistics Division (2015), assessing the quality
and suitability of secondary data is fundamental to ensure that the analysis
yields valid and reliable insights into gender disparities (p. 28).

Refer to Module Two of this manual for detailed information on finding the right
gender data.

Conduct Descriptive Analysis
4.1 Descriptive Analysis

o If using microdata, perform descriptive analysis to summarize the data and
highlight key gender differences in the variables of interest.

e Calculate summary statistics such as means, medians, and percentages,
and create visualizations like histograms and bar charts to present gender-
disaggregated data.

e As described by the European Institute for Gender Equality (2017),
descriptive analysis is an essential step in understanding the basic patterns
and distributions in gender statistics (p. 15).

4.2  Perform Comparative Analysis

e Compare gender-disaggregated data across different groups or time periods
to identify disparities and trends.

e If using microdata, carry out tests such as t-tests or chi-square tests to
compare means or proportions between gender groups and analyse trends
over time to detect changes in gender disparities.

o Comparative analysis is crucial for identifying significant gender disparities
and trends, as noted by UN Women (2018, p. 35).

4.3  Analyze Relationships Between Variables

e Explore associations between gender and other variables to understand the
factors contributing to observed disparities.
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e If using microdata, carry out regression analysis or correlation analysis to
examine the relationships between gender and other socio-economic or
demographic variables.

e Analysing relationships between variables helps to uncover the underlying
causes of gender disparities, as emphasized by Budlender (2015, p. 20).

Interpret Results in Context

Interpret the findings in the context of existing gender theories, policies, plans
and socio-cultural factors.

Relate the results to the broader socio-economic context and existing literature.

Interpretation of gender statistics should consider the broader socio-economic
and cultural context, as outlined by the United Nations Statistics Division (2015,
p. 34).

Report and Communicate Findings

Communicate the results clearly to stakeholders and policymakers, emphasizing
the implications for gender equality.

Prepare comprehensive reports, use visual aids for clarity, and ensure that the
findings are accessible to non-technical audiences.

Effective reporting of gender statistics is crucial for informing policy and
promoting gender equality, as highlighted by UNECE (2010, p. 40).

Example: “Reprocessed National Priority Gender Equality Indicators (NPGEIs) for Uganda,
2018.” “Proportion of women aged 20-24 years who were married or in a union before age 18”
as our example.

1.

Define Objectives and Research Questions

Objective: To assess the prevalence of child marriage in Uganda and its implications on
gender equality.

Research Questions:

What proportion of women aged 20-24 years were married or in a union before
the age of 18?

Are there significant differences in child marriage rates across different regions
of Uganda?

What are the socioeconomic factors associated with higher rates of child
marriage?

Determine if Pre-Processed Data Can Be Used
Pre-Processed Data:

e The “Reprocessed National Priority Gender Equality Indicators for Uganda,
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2018" already provides the proportion of women aged 20-24 who were
married before age 18.

Demographic and Health Survey (DHS) data for Uganda includes detailed
information on marriage age, demographics, and other related variables.

3. Identify and Access Relevant Data Sources

Relevant Data Sources:

Uganda Demographic and Health Survey (DHS) 2016
Uganda Bureau of Statistics (UBOS) reports
The 2018 Reprocessed National Priority Gender Equality Indicators dataset

United Nations Population Fund (UNFPA) reports on child marriage

4. Conduct Data Analysis

Data Analysis Steps:

Extract relevant data from the DHS dataset on the age of first marriage for
women aged 20-24.

Calculate the proportion of women who were married or in a union before
age 18.

Disaggregate the data by regions, socioeconomic status, and education
levels.

Perform statistical tests to determine significant differences across various
groups.

5. Interpret Results in Context

Results Interpretation:

Proportion of Child Marriage: The analysis might show that 40% of women
aged 20-24 were married before the age of 18.

Regional Differences: Higher rates of child marriage might be observed in
rural regions compared to urban areas.

Socioeconomic Factors: Higher prevalence of child marriage could be
associated with lower education levels and poorer households.

Contextual Interpretation:

High rates of child marriage in rural and low-income areas indicate a need
for targeted interventions.

The relationship between education and child marriage suggests that
increasing girls’ access to education could reduce child marriage rates.

EMBEDDING GENDER STATISTICS IN DECISION-MAKING
A Facilitator Guide for Training of Users of Gender Statistics in Uganda



6. Report and Communicate Findings
Reporting:

e Prepare a comprehensive report detailing the methodology, findings, and
interpretations.

¢ Include tables, charts, and graphs to visually represent the data.
Communication:

e Summarize key findings in policy briefs and presentations for stakeholders,
including government agencies, NGOs, and community leaders.

e Useinfographics and social media to raise public awareness about the issue
of child marriage and its impact on gender equality.

g Exercise 4.1: Gender Responsive Indicators

Would you consider the following indicators “gender responsive indicators”?
Why or why not?

1. Literacy rate in English at P3, by sex.

2. Maternal mortality ratio, per 100,000 live births.

3. Incidence of prostate cancer in Sub-Saharan Africa.

4. Proportion of women that undergo female genital mutilation/ cutting (FGM/C).

5. Number of youths apprehended by the UPDF during cattle raids in Karamoja subregion.
6. Proportion of households in Uganda using clean fuels for cooking.

7. Number of corruption cases prosecuted by the Inspectorate of Government in Uganda.

8. Percentage of Ugandan who women agree that wife-beating can be justified in specific
circumstances.

9. Proportion of Ugandan women who get married before 18 years.

10. Percentage of Ugandans who believe that women and men should not enjoy equal
rights to inherit property.
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10.

Answers to Exercise 4.1: Gender Responsive Indicators

Would you consider the following indicators “gender responsive indicators”?
Why or why not?

Literacy rate in English at P3, by sex. Yes, because the indicator name explicitly
mentions ‘by sex’.

Maternal mortality ratio, per 100,000 live births. Yes, because maternal deaths
concern women exclusively, and the indicator does not need sex disaggregation.

Incidence of prostate cancer in Sub-Saharan Africa. Yes, because prostate cancer
is an issue that concerns men exclusively.

Proportion of women that undergo female genital mutilation/ cutting (FGM/C).
Yes, because FGM/C concern women exclusively, and the indicator does not need sex
disaggregation.

Number of youths apprehended by the UPDF during cattle raids in Karamoja
subregion. Yes, this is a gender indicator even though it does not mention sex,
gender, or male youth. The reason is that it's mostly male youth who engage in cattle
raids in Karamoja subregion.

Proportion of households in Uganda using clean fuels for cooking. Yes, this is a
gender indicator even though it does not mention sex, gender, or women. The reason
is that more women are involved in cooking and tend to spend more time in the
household in most developing countries.

Number of corruption cases prosecuted by the Inspectorate of Government in
Uganda. No, this is not a gender indicator. It does not pertain to men or women and
there is no evidence of differentiated involvement of women and men in corruption.

Percentage of Ugandan who women agree that wife-beating can be justified in
specific circumstances. Yes, this is a gender indicator because of two reasons. The
indicator is about women as victims of intimate partner violence. The indicator, as
stated, is measured based on interview responses from women.

Proportion of Ugandan women who get married before 18 years. Yes, this is a
gender indicator because it explicitly mentions women.

Percentage of Ugandans who believe that women and men should not enjoy
equalrights to inherit property. No, this is not a gender indicator because ‘Ugandans’
is not sex-disaggregated.
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SESSION 4.2: PRESENTING GENDER STATISTICS USING PERCENTAGES, RATIOS

AND RATES

Session objective:

Methods:

Requirements:

Preparation:

Duration

Activity

Notes/Handouts

e Understood how to define and differentiate between the
various types of statistical measures.

e Understood the formulae and steps for calculating each
measure.

e Understood how to interpret each measure.

e Gained proficiency in presenting each measure in gender
information products.

e Appreciated the applicability and limitations of each
measure.

A facilitator's presentation, demonstration, and individual
exercise

A projector, a computer, flip chart papers, marker pens, and
masking tape

Practice the individual exercises to lead the demonstration
exercises

180 minutes

4.2: Presenting Gender Statistics using Percentages and
Related Measures

4.2: Presenting Gender Statistics Using Rates, Ratios,
Percentages, and Related Measures

Activity 4.2: Presenting Gender Statistics using Percentages and Related Mea-
sures

i. Introduce the session by informing the participants about the different statistical
measures applicable in gender statistics.

ii. Guided by the Notes (Handout 4.2), demonstrate how each measure is computed
in Microsoft Excel.

lii. You can begin by asking some participants to demonstrate how to calculate each

measure
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Notes/ Handout 4.2: Presenting Gender Statistics Using Rates, Ra-
ﬂ tios, Percentages, and Related Measures

Measures such as ratio, rate, proportion, percentage, and percentage points
are statistically different. It is important to understand the differences and avoid using
these words interchangeably.

Ratio

A ratio shows the magnitude of one quantity relative to another. In gender statistics,
a ratio is used to measure differences in representation, participation, or outcomes
between females and males.

Examples:
a) Pupil: senior teacher ratio (senior women teachers, senior men teachers)
b) Pupil: latrine stance ratio (girls, boys, total)

Rate

A rate compares the number of occurrences of an event to the total population at risk,
usually expressed per 1,000 or 100,000 individuals, over a specific period.

Examples:

¢) Adolescent birth rate i.e. the number of births delivered by women aged 15-19
years per 1,000 women in that age group.

d) Average number of deaths per road accident (females, males)
Proportion

A proportion is a fraction or share of the total units. For example, the proportion of seats
held by women in national parliaments is calculated by dividing the number of seats
held by women in the national parliament by the total number of seats in the national
parliament.

= Seats occupicd by women

@8
a® Total seats
[ ]
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Percentage

A percentage is a proportion of the whole population multiplied by one hundred.
Proportions are often expressed as percentages. E.g. ‘Proportion of time spent on
unpaid care and domestic work’. We could say that someone spends three out of 12
hours on unpaid care and domestic work.

3 out of 12 hours spent on 25 % of the time spent on
unpaid work (proportion) unpaid work

Do not use percentages when the total size of your sample or population is small, as the
results may be deceptive.

Percentage point change Versus Percentage change

A percentage point change is the absolute difference between two percentages. A
percentage change measures the relative change compared to the original quantity.
It is very important to understand that percentage change and percentage difference are
completely different concepts and cannot be used interchangeably.
hrrlabiic diffrai coficiits Snd et b (o ntiireFmoafidbti Percontage vs

percentage polmts

A epcted inothee gragsh,
the adoloscent hirth rato
s 1119 b 2004 and
decreasod 109,19 in

FLT R

Actolacomnt birth rate [jpor D00,000 womos,
apes 15-19) In China

There was a dropof 2
pescentage points (11,109
=919 = 2} bait ond Eoold
say that the adolescent
Ll th rate dropped by 16
per cont, To calculaie the
porcontage drog, wee
sl P ta apply Bl
farmula:

HIEE 2014 BILE B 2014 foilil (11 B —219)/1119 =

17.8%

Sample Calculation Using UNHS Poverty Rate
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Figure 13: Percentage Point Change

{ oW Il.'|'l|1' ”l;l‘\.l.llu.‘ ' , H"}

Yaraanti T W
Percentage Change O Value

For the poverty rates
Percentage Change = (<g=—=) x 100

Percentage Change {'_n.l,ff}' 100 = =7 88%

This indicates a 7.80% relative reduction in the poverty rate from 2019/20 to 2022/23

SESSION 4.3: PRESENTING GENDER STATISTICS USING THE COMMON MEA-

SURES OF CENTRAL TENDENCY AND DISPERSION

Session objective: e Understood how to define and differentiate between the
various measures of central tendency and dispersion.

e Understood the formulae and steps for calculating each
measure of central tendency and dispersion.

e Understood how to interpret each measure of central
tendency and dispersion.

e Gained proficiency in presenting each measure of
central tendency and dispersion in gender information
products.

e Appreciated the applicability and limitations of each
measure of central tendency and dispersion.

Methods: A facilitator's presentation, demonstration, and individual
exercise

Requirements: A projector, a computer, flip chart papers, marker pens, and
masking tape

Preparation: Practice the individual exercises to lead the demonstration
exercises, pre-arranged dataset

Duration 180 minutes

Activity 4.3: Presenting Gender Statistics using the Common Measures

of Central Tendency and Dispersion
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Notes/Handouts 4.3A: Presenting Gender Statistics Using the Common Measures
of Central Tendency

4.3B: Presenting Gender Statistics Using the Common Measures
of dispersion

Activity 4.3: Presenting Gender Statistics using the Common Measures of Central
Tendency and Dispersion

i. Introduce the session by informing the participants about the different measures
of central tendency applicable in gender statistics.

ii. Guided by the Notes (Handout 4.E), demonstrate how each measure is computed.
You can begin by asking some participants to demonstrate how they calculate
measures of central tendency (mean, median) and measures of dispersion (Range,
interquartile range, Standard Deviation, Coefficient of variation)

a. Mean
b. Median
c. Sum

d. Standard Deviation

Notes/ Handout 4.3A: Presenting Gender Statistics Using the Com-
9 mon Measures of Central Tendency

Mean

Mean is the sum of all the values in a set, divided by the total number of values. It is the
most used measure of central tendency. The mean is also referred to as “average” by
some statisticians and statistical packages such as Excel and SPSS.

Usefulness of mean as a measure in gender statistics:

i. Comparison of patterns for women and men: For example, comparing the
average income or educational attainment of men and women can highlight
gender parity or disparity.

ii. Identifying trends between women and men: By analysing changes in the mean
over time, researchers can identify trends and progress in gender equality. For
example, tracking the mean years of schooling for men and women over several
decades can show advancements or setbacks in educational attainment.

ili. Aggregating data: The mean is useful for summarizing large data sets into a
single value, making it easier to understand the gender trend or pattern within
the data.
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iv. Assessing and comparing the impact of interventions: The mean can help
in evaluating the effectiveness of interventions aimed at reducing gender
disparities. For example, if a programme is implemented to increase female
participation in the workforce, comparing the mean employment rates before
and after the intervention can provide insights into its impact. Relative gender
impact can be compared across interventions.

Weaknesses of mean as a measure in gender statistics:

The ‘mean’ is a good measure for normal distributions, but it is influenced by outliers’.
An outlier will pull the value of the mean in its direction and away from the location of
most of the observations.

For instance, in the dataset named ‘Uganda Survey Sample EPRC Manual’, the mean
income for men is closer to the minimum than to the maximum income

SEX Average of INCOME Min of INCOME Max of INCOME

F 541,832.99 271,800.00 984,640.00
M 725,938.39 351,118.18 1,600,000.00
Grand Total 655,364.66 271,800.00 1,600,000.00

Steps of computing the mean of continuous data using Excel Pivot Tables
1. Insert a Pivot Table
e Highlight the entire data range including headers.
e (o to the Insert tab and click PivotTable.
2. Choose Data Source:
e Confirm the selected data range.

e Choose where to place the Pivot Table (New Worksheet or Existing
Worksheet).

e Click OK to create the Pivot Table.
3. Arrange Fields in the Pivot Table
a) Drag Fields:

o Inthe PivotTable Field List, drag the field for which you want to calculate the
mean (e.g., Income) to the Values area.

o Drag the category field (e.g., Sex) to the Rows area.
b) Set the Calculation to Average:
o Click on the field in the Values area (it might default to “Sum of Value”).

o Select Value Field Settings.

1 Outliers are data points that significantly differ from other observations in a dataset.
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o Choose Average from the list of calculations.
o Click OK.
4. View the Results

Your Pivot Table will now display the mean values for each category. It
automatically calculates and presents the average of the Value field for each
unique Category.

5. Customize and Format
a) Formatting:

o Right-click on the numbers in the Pivot Table and choose Number Format to
adjust the number of decimal places or apply other formatting options.

b) Filtering and Sorting:

o Use the drop-down menus on the row labels or values to filter or sort your
data.

c) Add More Fields:

o You can add more fields to the Rows or Columns areas to further break down
the data, if needed.

6. Refresh Data

If you update the source data, you can refresh the Pivot Table by right-clicking it
and selecting Refresh to update the mean calculations.

Example:

Inthe dataset named ‘Uganda Survey Sample EPRC Manual’, the mean, minimum,
and maximum income for women, men and overall are as follows:

SEX Average of INCOME Min of INCOME Max of INCOME

F 541,832.99 271,800.00 984,640.00
M 725,938.39 351,118.18 1,600,000.00
Grand Total 655,364.66 271,800.00 1,600,000.00
Median

The ‘median’ is the middle value of an ordered data. It is calculated by first
arranging the data from smallest to largest, and then counting up to half the
observations. The median is either the value at the center of the ordered data
in the case of an odd number of observations or the simple average of the two
middle observations if the total number is even.
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Steps of computing the median of continuous data using Excel

80

The pivot calculation functions do not include the median.

Therefore, use the MEDIAN function outside the Pivot Table to calculate the
median of your data.

If not displayed on the formula ribbon, use the Excel search box to locate the
function for median.

iv. Using our dataset ‘Uganda Survey Sample EPRC Manual’: =MEDIAN(H2:H121)
where H2:A121 represents our data range.

v. The median value in the dataset ‘Uganda Survey Sample EPRC Manual’ is UGX
546,550.

Total/ Sum

The total/ sum value is the result of adding up all values in a data set.

Examples:

People living in poverty: For instance, when measuring poverty, we can say
that roughly 730 million people lived below the poverty line in 2015, or about
10 percent of the world’s population. The former value (730 million) is the total
value.

Enrolment in school: This is the total number of learners admitted/re-admitted
and fully recorded in the school’s register at the beginning of the first term. It
includes all those learners whose names appear on the school register (including
repeaters and those temporarily absent).

Usefulness of total as a measure in gender statistics:

Quantifying population size: The total number of men and women in different
categories (e.g., employment sectors, educational levels) provides a clear picture
of the population distribution. This helps in understanding the scale of gender
differences.

Resource allocation: Totals are crucial for allocating resources and funding. For
example, knowing the total number of women who need access to healthcare
services can inform policy decisions and budget allocations.

Policy impact assessment: Assessing the total impact of gender-focused policies
and programmes often involves summing up individual outcomes. For example,
the total number of women who received funds from the Parish Development
Model (PDM) can indicate the reach and effectiveness of the programme.

Identifying gaps and needs: Totals help in identifying gaps and needs in services
or interventions. For instance, the total number of girls out of school compared
to boys can highlight areas where educational interventions are needed.

Trend analysis: Totals can help track trends over time. For example, the total
number of women in leadership positions across years can indicate progress or
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stagnation in achieving gender equality in leadership.

Weaknesses of total/ sum as a measure in gender statistics:

iv.

Vi.

Hiding disparities: Summarizing data with totals can mask underlying disparities.
For instance, the total income of men and women might be similar, but the mean
or median income could reveal significant gender wage gaps.

Sensitivity to population size: Totals are heavily influenced by the size of the
population. Larger populations will naturally have higher totals, which can make
it difficult to compare data between groups of different sizes.

In our dataset ‘Uganda Survey Sample EPRC Manual’, the sum of income for
women and men differs greatly, but this ignores the proportion of women and
men in the sample, which is 38.3% and 61.7% respectively.

Sum of INCOME

SEX Total

F 24,924,317.62
M 53,719,441.06
Grand Tot 78,643,758.68

Overlooking variability: Totals do not account for variability or diversity within
groups. For example, the total number of women in higher education does not
show variations in fields of study.

Ignores inter-group size: For instance, a high total number of women in a certain
profession might suggest gender equality, but without considering the proportion
relative to men, it might not accurately reflect the true state of gender balance.

Ignoring per capita differences: Totals ignore per capita differences which are
often more informative. For example, the total number of women in Science,
Technology, Engineering, and Mathematics (STEM) fields is less informative
than the proportion of women in STEM relative to the total population of women.

Not showing relative change: For instance, if we only say, “the number of
Ugandans living in poverty increased from 8.0 million in 2016/17 to 8.3 million
in 2019/20 (UNHS)", it appears as a negative development. However, due to
overall population increases, it is possible that the actual poverty rates might
have dropped over time, which is a positive development. Indeed, the proportion
of the population living in poverty reduced from 21.4 percent in 2016/17 to 20.3
percent in 2019/20.

Steps of Computing the Sum of Continuous Data using Excel

i. Insert a Pivot Table:
e Select any cell within your data range.
e Go to the “Insert” tab on the Ribbon.

e Click “PivotTable!” The “Create PivotTable” dialog box will appear.
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o Verify the data range and choose whether to place the PivotTable in a new
worksheet or an existing worksheet. Click “OK"”

ii. Configure the Pivot Table:

e Inthe “PivotTable Fields” pane on the right, drag the field that contains your
continuous data (e.g., “Values”) into the “Values” area.

iii. Change the Aggregation Function to Sum:
e By default, Excel might use the “Count” function. To change this to “Sum”:
o Click the drop-down arrow next to the field name in the “Values” area.
o Select “Value Field Settings.”

o Inthe “Value Field Settings” dialog box, select “Sum” under the “Summarize
Values By” tab.

o Click “OK”
iv. View the Results:

e The Pivot Table will now display the sum of the continuous data.

Notes/ Handout 4.3B: Presenting Gender Statistics Using the Com-
mon Measures of dispersion

i

Range

The range is represented by the smallest and largest observations in a dataset, making
it the simplest measure of variability. In statistics, the range is specified by these two
values, not by the difference between them. This measure can be very useful for certain
data, such as knowing the ages of the youngest and oldest participants in a sample.
However, the presence of outliers can distort the impression of data variability, as the
range only considers these two observations.

Quartiles and Interquartile Range

The quartiles, including the lower quartile, the median, and the upper quartile, divide
the data into four equal parts, meaning there will be roughly equal numbers of
observations in each section (exactly equal if the sample size is divisible by four and
the measurements are distinct). Note that there are only three quartiles, and these are
points, not proportions. It is acommon misuse of language to say someone is ‘in the top
quartile’; instead, one should say ‘in the top quarter’ or ‘above the top quartile’. Quartiles
are calculated similarly to the median: first, arrange the data in ascending order and find
the median. Then, split the data into two halves (lower and upper). The first quartile is
the middle observation of the lower half, and the third quartile is the middle observation
of the upper half. This process is illustrated in the example below.

The interquartile range (IQR) is a useful measure of variability, defined by the lower

82 EMBEDDING GENDER STATISTICS IN DECISION-MAKING
A Facilitator Guide for Training of Users of Gender Statistics in Uganda



and upper quartiles. The IQR is not affected by outliers, and regardless of the data
distribution, 50% of the observations lie within this range.

Example on calculation of the quartiles
Suppose we had 18 birth weights arranged in increasing order.

1.51,1.53. 1.565, 1.55,1.79. 1.81, 2.10, 2.15, 2.18, 2.22, 2.35, 2.37, 2.40, 2.40, 2.45, 2.78.
2.81,2.85.

The median is the average of the 9th and 10th observations (2.18+2.22)/2 = 2.20 kg.
The first half of the data has 9 observations so the first quartile is the 5th observation,
namely 1.79kg. Similarly, the 3rd quartile would be the 5th observation in the upper half
of the data, or the 14th observation, namely 2.40 kg. Hence the interquartile range is
1.79 to 2.40 kg.

Variance

Variance measures the extent to which data points in a dataset differ from the mean.
It is calculated as the average of the squared differences between each data point and
the mean. This squaring amplifies the effect of outliers, making variance particularly
sensitive to extreme values. Higher variance indicates that data points are more spread
out from the mean, while lower variance signifies that they are closer to the mean.
However, because variance is in squared units of the original data, it can sometimes be
less intuitive to interpret directly.

Standard Deviation

Standard deviation (SD) measures how spread out or dispersed the values in a data set
are from the mean. A low standard deviation indicates that the values tend to be close
to the mean of the set, while a high standard deviation indicates that the values are
spread far away from the mean. In practical terms, it helps to assess the consistency
of the data.

In our dataset named ‘Uganda Survey Sample EPRC Manual’, the SD values are:

SEX StdDev of INCOME Average of INCOME:
F 185,712.50 541,832.99
M 328,880.95 725,938.39
Grand Total 295,759.51 655,364.66

The relatively lower SD suggests that the incomes for females are more closely clustered
around the average income. Whereas the higher SD for males indicates that the income
for males is more spread out, with a wider range of values around the average. The
overall SD reflects the combined variability for both sexes. It's higher than the standard
deviation for females and lower than that for males.

Steps of Computing Standard Deviation of Continuous Data using Excel

i. Create a Pivot Table:
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a) Select any cell within your data range.
b) Go to the “Insert” tab on the Ribbon.
c) Click on “PivotTable." This will open the “Create PivotTable” dialog box.

d) Verify the datarange and choose where you want the PivotTable to be placed
(either a new worksheet or an existing one). Click “OK."

ii. Configure the Pivot Table:

a) Inthe “PivotTable Fields” pane, drag the field with your continuous data (e.g.,
“Values”) to the “Values” area.

iii. Change the Aggregation Function:
a) By default, the PivotTable will sum the values. To change this:
o Click on the dropdown arrow next to the field name in the “Values” area.
o Select “Value Field Settings.”
o Inthe “Value Field Settings” dialog box, select the “Show Values As” tab.

o Choose “Standard Deviation” from the list of summary functions. You may
need to select “Standard Deviation” (for a sample) or “Standard Deviationp”
(for the entire population) depending on your data.

iv. Apply and Review:

a) Click “OK" to apply the changes.

b) Your PivotTable will now display the standard deviation of the sample data.
v. Format the PivotTable (Optional):

e) You can format the PivotTable to better display the results by adjusting
column widths, applying number formatting, and customizing the layout as
needed.

Coefficient of Variation (CV)

The coefficient of variation is the ratio of the standard deviation to the mean, expressed
as a percentage. It is useful for comparing the relative dispersion of datasets with
different units or means.
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SESSION 4.4: DATA ANALYSIS WITH EXCEL

Session objective: e Understood how to define and differentiate between a
bivariate and multivariate

e Understand how to conduct simple regression analysis
in Excel.

e Understood how to interpret each measure of central
tendency.

e How to activate the Toolpak tools to conduct analysis in

excel
Methods: A facilitator's presentation, demonstration, and individual
exercise
Requirements: A projector, a computer, dataset
Preparation: Pre-arranged dataset
Duration 240 minutes
Activity 4.4 How to use own trainee data to conduct analysis in Excel
Notes/Handouts 4 AA: Bivariate and multivariate analysis

4.3B: Data management and generation of basic descriptive
statistics with formulars

Exercises To be generated during the sessions using sample datasets
from trainees

Answers to exercises To be generated during the sessions using sample datasets
from trainees

Activity 4.4 How to use own trainee data to conduct analysis in Excel

Steps:

Each trainee shares a small dataset they frequently work with.

o Trainers review the datasets to ensure diversity in data types (numeric, categorical,
time series, etc.).

o Trainees identify inconsistencies, missing values, and formatting issues.

o Use Excel to clean the data.

o Trainees generate basic statistics (mean, median, mode, standard deviation).
o Create summary tables

o They analyze trends, correlations, or patterns and create a short report.

o Present their findings in a 5-minute presentation to the group.
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e Trainers provide feedback on each presentation.
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e Group discussion on key challenges and lessons learned.

e Summary of best practices in data handling.

i

Handout 4.4A: Bivariate and multivariate analysis

BIVARIATE ANALYSIS

Bivariate analysis measures the association of two variables to understand the
relationship between them. This type of analysis is fundamental in statistics and helps in
identifying patterns, correlations, and potential causal relationships. Bivariate analysis
can be applied to both categorical and continuous variables, using different methods
depending on the nature of the data.

Types of Bivariate Analysis

a) Scatter Plot: A scatter plot is a graphical representation of two continuous
variables. Each point on the plot represents an observation. Scatter plots help in
visualizing relationships, showing patterns, trends, and potential outliers.

b) Correlation: Correlation measures the strength and direction of the linear
relationship between two continuous variables. The correlation coefficient, r. r, ranges
from-1to 1. A value close to 1 indicates a strong positive correlation, while a value close
to -1 indicates a strong negative correlation. A value around 0 indicates no correlation.

c) Simple Linear Regression: Simple linear regression is used to model the
relationship between two continuous variables by fitting a linear equation to observed
data. The equation is of the form y=mx+b, where y is the dependent variable, x is the
independent variable, m is the slope, and b is the intercept.

d) Crosstabulation (Contingency Table): For categorical data, a crosstabulation
(or contingency table) displays the frequency distribution of the variables. It helps in
understanding the association between two categorical variables by showing the
number of observations that fall into each category.

e) Chi-Square Test: The chi-square test is used to determine if there is a significant
association between two categorical variables. It compares the observed frequencies in
the contingency table with the expected frequencies, assuming no association between
the variables.

f) T-Test and ANOVA (Analysis of Variance): T-Test: For comparing the means of
two groups, especially when one variable is categorical (with two levels) and the other is
continuous. While ANOVA compares the means across more than two groups.

MULTIVARIABLE ANALYSIS

Multivariable analysis involves examining more than two variables simultaneously to
understand the relationships between them and to control for the influence of multiple
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factors. This type of analysis is crucial in complex data scenarios where multiple
factors interact and contribute to the outcomes. For example, a multivariable analysis
-multiple linear regression’ may be used to examine the factors that influence the wage
gap between men and women. This among other factors could be influenced by gender,
education level, work experience, Occupation type, location among other factors.

Logistic Regressions:

Binary logistic regression is a statistical method used for modeling the relationship
between a binary dependent variable and one or more independent variables. It is
particularly useful when the outcome of interest is categorical with two possible values,
such as success/failure, yes/no, or 0/1.

Ordered logistic regression, also known as ordinal logistic regression, is a statistical
technique used to model the relationship between an ordinal dependent variable and
one or more independent variables. An ordinal variable is a categorical variable where
the categories have a meaningful order but the intervals between categories are not
necessarily equal. Examples include satisfaction ratings (e.g., dissatisfied, neutral,
satisfied) or education levels (e.g., high school, college, graduate).

Multinomial logistic regression is a statistical technique used to model the relationship
between a categorical dependent variable with more than two levels and one or more
independent variables. Unlike binary logistic regression, which is used for binary
outcomes, multinomial logistic regression handles situations where the dependent
variable has multiple categories with no inherent order.

Multivariate analysis.
Multivariate Analysis of Variance (MANOVA)

MANOVA extends ANOVA by examining multiple dependent variables simultaneously
to determine if the means of the dependent variables differ significantly across groups.
It assesses the effect of one or more independent variables on multiple dependent
variables.

Principal Component Analysis (PCA):

PCA is a dimensionality reduction technique used to reduce the number of variables in
a dataset while retaining most of the variance. It transforms the original variables into a
new set of uncorrelated variables called principal components.

Factor Analysis:

Factor analysis identifies underlying relationships between variables by grouping them
into factors. These factors represent latent constructions that influence the observed
variables.

Cluster Analysis:
1 Multiple linear regression extends simple linear regression by modeling the relationship between a dependent variable

and multiple independent variables.
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Cluster analysis groups similar observations into clusters based on the characteristics
of multiple variables. It is used for segmenting data into meaningful groups.

Hand out 4.4B: Data management and generation of basic descrip-
9 tive statistics with formulars

Data Cleaning:

Removing Duplicates: Select the range or table, go to the “Data” tab, and click “Remove
Duplicates.” Choose the columns to check for duplicates and click “OK.” This eliminates
redundant records which might skew analysis results.

CONCATENATE or CONCAT:

Formulas: '=CONCATENATE(text1, text2, ...)" or '=CONCAT (text1, text2, ...)" this allows
combining text from multiple cells into one.

TEXT TO COLUMNS:

How to Use: Select the column, go to “Data” > “Text to Columns,” choose “Delimited” or
“Fixed width,” and follow the wizard to split text into columns. The purpose of this is to
Splits data into multiple columns based on delimiters like commas or spaces.

Handle Missing Data:

Fill Missing Values: You can fill missing values using methods like mean imputation
(e.g., =AVERAGE (range)’) or forward/backward filling.

Remove Missing Values: Filter out rows with missing data or use the “Find & Select” >
“Go To Special” > “Blanks” to identify and manage them. This ensures completeness of
data for accurate analysis.

Organize Data:

Sort Data: Select the data range, go to the “Data” tab, and choose “Sort.” You can sort
by one or more columns, in ascending or descending order. One can even custom sort
according to the variable of interest. This facilitates easier analysis and comparison by
ordering data logically.

Filter Data: Select the data range, go to the “Data” tab, and click “Filter.” Use dropdowns
in column headers to filter data based on criteria. This focuses on specific subsets of
data for detailed analysis.

How to generate basic descriptive statistics with formulars
Mean: Formula: "=AVERAGE(range)

Median: Formula: '=MEDIAN(range)’
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Mode: Formula: '=MODE.SNGL(range) or '=MODE.MULT(range)" for multiple modes.

Standard Deviation: Formula: *=STDEV.S(range)" (for sample) or *=STDEV.P(range)" (for
population) or =STDEV(range)

Summary Statistics:
COUNT: Formula: '=COUNT(range)" it counts the number of numeric entries in a range.

COUNTA: Formula: '=COUNTA(range)" it counts all non-empty cells in arange, regardless
of data type.

MAX/MIN: Formulas: "=MAX(range)’ and "=MIN(range)" it identifies the highest and
lowest values, which are useful for range and outlier detection.

Box ....How to perform a regression in Excel

Go to “Data” > “Data Analysis” > “Regression.” Input the Y Range (dependent variable)
and X Range (independent variables). This models relationships between variables
and predicts outcomes based on predictor variables. It displays coefficients,
R-squared values (goodness of fit), p-values (statistical significance). The purpose
is to understand the strength and significance of relationships between variables.

_'IIHII mi
Regression ? X

]

Input ¥ Range: $151:51$121 +
a Cancel
g Input X Range: $G$1:$H%121 +

| . Hel

2 s Labels D Constant is Zero i

s Confidence Level: 95 %

Output options

[

C_ O Qutput Range:
o New Worksheet Ply:
O New Workbook

Residuals
s Residuals s Residual Plots
s Standardized Residuals s Line Fit Plots

Normal Probability
(] Normal Probability Plots
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Go to “Data” > “Data Analysis” > “correlation” Input the Range for two variables you want
to measure association of. The purpose is to measure the strength and direction of the
linear relationship between two variables.

Results.
A B C
| INCOME SAVING
'’ INCOME 1
} SAVING  0.766855 1

Advanced data analysis using pivot tables:
How to creating a pivot table:

> Go to “Insert” > “PivotTable,” select the data range, and choose where to place
the PivotTable. Drag and drop fields into the Rows, Columns, Values, and Filters areas.
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This summarizes, aggregates, and analyzes large data sets dynamically.

How to create pivot charts:

» Click inside the PivotTable, go to “PivotTable Analyze” > “PivotChart,’ and choose
the chart type. This Creates charts based on PivotTables to visualize aggregated
data.

Data Analysis Toolpak:

How to add or activate the Toolpak:

Go to “File” > “Options” > “Add-Ins” > “Excel Add-ins” > “Analysis Toolpak” and click “Go,”
then check “Analysis Toolpak” and click “OK.” This allows advanced statistical analyses
like regression, ANOVA, and histograms.
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Using the Toolpak:

Go to “Data” > “Data Analysis,” and select the analysis tool you need (e.g., “Regression,”
“Descriptive Statistics”). This performs detailed statistical analysis and hypothesis
testing.
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Formulas and functions:
IF function:

Formula: “=IF(logical_test, value_if_true, value_if_false)® This applies conditional logic
to return different values based on criteria.

VLOOKUP/HLOOKUP/XLOOKUP:
Formulas:

"=VLOOKUP(lookup_value, table_array, col_index_num, [range_lookup])® for vertical
lookups, "=HLOOKUP(lookup_value, table_array, row_index_num, [range_lookup])" for
horizontal lookups.

=XLOOKUP(lookup_value, lookup_array, return_array, [if_not_found], [match_mode],
[search_mode])

These lookup functions allow searches for a value in a table and returns a corresponding
value from another column or row. It also aids merging two datasets.

INDEX/MATCH:

Formulas: "=INDEX(array, row_num, [column_num])" combined with "=MATCH(lookup_
value, lookup_array, [match_type])® for flexible lookups. It provides more powerful
lookups compared to VLOOKUP/HLOOKUP, especially for large data sets.
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MODULE VISUALIZING
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GENDER
STATISTICS




MODULE FIVE: VISUALIZING GENDER
STATISTICS

O/v LEARNING OUTCOMES/OBJECTIVES

By the end of this module, participants are expected to have:
a. Understood the various options for visualizing gender statistics.

b. Learned the basic skills for visualizing gender statistics.

OVERVIEW OF THE MODULE
The modules cover how to generate visuals on gender issues using Microsoft

Excel. It further explores infographics as one of the data visualization tools
and associated qualities.

— 2 NOTE TO FACILITATOR

—=| Facilitators should highlight the importance of visualizing gender statistics
to simplify complex data. Emphasize how Microsoft Excel can be used
effectively for data visualization to create bar charts and graphs among
others. Facilitators should explain the benefits of replacing or complementing
text with visuals in reports and publications,

. TIME:
k.: 5 HOURS
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SESSION 5.1: GENERAL GUIDANCE FOR DATA VISUALISATION

Session objective: By the end of this session, participants are expected to have

a) Learned the basic skills for generating charts and graphs
using Microsoft excel

b) Understand how data visualization enhances the
interpretation of gender statistics through various visual
formats such as charts, graphs, and infographics.

Methods: PowerPoint presentation, demonstration, hands-on practical
exercises, group discussions, Q&A

Requirements: A projector, a computer, dataset in Excel

Preparation: Before the session, the facilitator should print out examples of

visuals to be used, generate a workable sample data set to be
used generating visuals using Excel

Duration 300 minutes

Notes/Handouts 5.1A: General Guidance for Data Visualisation

5.1B: Examples of Data Visualization on Microsoft Excel

Exercises 5.1A: Creating a bar chart of a dataset in Microsoft Excel

5.1B: Qualities of a good infographic

Answers to exercises 5.1A: Creating a bar chart of a dataset in Microsoft Excel

5.1B: Qualities of a good infographic

9 Notes/ Handout 5.1A: General Guidance for Data Visualisation

Data visualization is the presentation of data or information in a graph, chart,

or other visual formats. Visualizing data makes massive datasets easier for
people to understand. Excel is widely used for data visualization, owing to its excellent
data visualization features.

While the approach to data visualization may depend on the topic, detail, and length of
an information product, some guidelines for data presentation and visualization include:
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1. Replace or complement text with visuals where possible and relevant: Long
pieces of text can be boring and monotonous to readers. Adding relevant text
in a box can also help break the monotony of the content and highlight a key
message. Figure 14 shows an excerpt from a UN Women publication. Although
much text has been included, a change in typography (colour of headlines, font
style and size) as well as addition of a simple bar chart makes it engaging for the
reader.
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Figure 14: Example of visualization
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2. Add complimentary elements and context to visuals: Ensure graph titles are
comprehensive, accurate, and easily understandable. Use subtitles, footnotes,
and short explanations to convey accurate messages.

3. Present women and men side by side in graphs for easy comparison. Always use
“women” and “men” instead of “female” and “male” to avoid social connotations.

4. Round numbers appropriately for broader audience understanding; round
to 1,000, 100, or 10 for numbers, and round percentages to whole numbers
(integers).

5. Select culturally and politically appropriate icons for gender statistics
presentations.

Align alphabetic text left and numeric values right in tables.
Prefer clear visual charts over tables whenever possible.

Avoid excessive categories in pie charts and stack bar charts.

© © N o

Use consistent colours for women and men across all charts.
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10. Simplify chart layouts to enhance clarity.

11. Understand print size limits when designing visuals.

12. Utilize gender statistics effectively in non-statistical reports.

13. Provide insights and context for gender data, discussing data limitations.

14. Balance text and graphs to engage readers effectively. Use text to explain the
key messages in the visuals without explaining every data point.

15. Footnote all data sources and references for transparency and additional
information access.

9 Notes/ Handout 5.1B: Examples of Data Visualization on Microsoft
Excel

Your Excel data could probably look like the datain Figure 15, but it can be difficult
for numbers to communicate data-related trends. Using Excel, data can be transformed
into charts Figure 16 and graphs to communicate relevant gender statistical trends

Figure 15: Data table that does not communicate trends

A B = V] E F G H J K L M
1 Jan Feb Mar  Apr May  Jun Jul Aug Sep Oct Nov Dec
> Products 113824 188986 140691 167417 199789 122998 104406 162634 170378 171745 130481 158238
: Services 320651 345882 282953 197752 385273 298660 156515 188593 374634 278056 208716 240923
: Total revenue 434475 534868 423644 365169 585062 421658 260921 351227 545012 449801 339197 399161
|Sa|es count 155 255 195 205 218 122 286 291 119 184 120 178

Source: Opio (2022)
Charts/ graphs

Figure 16: Sample bar chart

Revenue by Maonth
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Source: Opio (2022)
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Figure 16 above on products and services revenue by month shows that services are
always higher than products, but more volatile. This information would be hard to
understand from numbers alone! The same data can also be turned into a bar chart, line
graph, or other graphs.

How to create a chart or graph:

1.

e

© N o g & W N

If already analysed into a table of say mean income, open the Excel data table. If
not analysed, use pivot table process for generating charts.

Select the data with your mouse.

Select Insert from the menu bar.

Select Chart.

Select Bar chart.

Select “Data” from the menu bar.

Select “Sort”. Select to sort by value, and smallest to largest.

Select the “Chart Design” option on the right side of the menu bar and add “Chart
elements”.

Select chart title and name it appropriately.

11. Add data labels.

Figure 17: Sample stacked bar chart

Revenue by Month

| " |
| )
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B Prodiucts & 5enyices

Source: Opio (2022)

The above steps can be followed to create other types of charts, such as a line graph,
area Chart, scatter plots, etcetera.
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J Exercise 5.1A: Creating a bar chart of a dataset in Microsoft Excel

g Using our dataset ‘Uganda Survey Sample EPRC Manual’, build a clustered bar
chart, showing the average income by educational level and sex. Add the chart
title, data labels and axis title to complete the visualization.

Average of INCOME

Average income of Respondents, by eduation
level and sex

bg, 66/
4 ; 676,459
tovcvie - [ T

=]

I

517,947 mo
é 477,459

; 710,807

200000 400000  &s00000 ROOOOC 1 000,000

Source: EPRC (2023)

Answers to Exercise 5.1A: Creating a bar chart of a dataset in Mic-
g rosoft Excel

Check the outputs created by 3 to 5 participants and provide general comments
in plenary.

Pie Chart

A pie chart gives the contribution of a category within the same variable. Pie charts are
circular depictions of statistical proportions, using divisions. The bigger the slice of the
pie, the larger the representation, and more generally, the importance. To create a pie
chart, select the requisite columns, and click on the required pie chart option from the
Pie option as shown below.

Figure 18: Sample pie chart

Revenue by Region
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Source: Nsubuga et al, (2020)

Box ...How to generate charts and graphs in excel

To draw a chart in Excel, first enter your data into a worksheet, ensuring it's organized
with headers. Highlight the cells containing your data, including headers. Next, go to
the “Insert” tab on the Ribbon and choose a chart type (e.g., Column, Line, Pie, Scatter)
that best represents your data. After the chart appears, click on the chart title to edit
it and add a meaningful title. Use the “Chart Elements” button (plus sign) to add axis
titles, legends, and data labels. Customize your chart's appearance using the “Chart
Styles” button (paintbrush icon) and right-click on various chart elements to format
them individually. Resize and move the chart by clicking and dragging its corners or
the entire chart. To modify the data series, right-click on the chart and select “Select
Data.” If a different chart type is needed, right-click on the chart and choose “Change
Chart Type.” Save your workbook to preserve your chart, or right-click the chart and
select “Save as Template” for future use. You can also copy the chart (Ctrl+C) and
paste it (Ctrl+V) into other documents or export it as an image by right-clicking and
choosing “Save as Picture.”

Note:

a) Column chart is ideal for comparing data across categories. One can adjust
colors, axis labels, and data labels for clarity.

b) Bar charts are useful for displaying categorical data.

c) Linechartis best used when showing trends over time or continuous data. One
can add markers, trendlines, and gridlines to enhance readability.

d) Pie chart shows proportions of a whole. Best used when there are a few
categories. One can adjust slice colors and add data labels for clarity.

e) Scatter plot displays relationships between two numerical variables. One can
add trendlines, adjust axis scales, and use different marker styles.

Tables

Although tables may not be as appealing as graphs, tables are a necessary form for
presentation data for the following reasons:

1. They can present precise values, including specific counts, percentages, and
other precise metrics.

2. Tables may contain comprehensive information on several characteristics and
indicators, such as gender statistics broken down by age groups, regions, and
other demographic factors.

3. The distribution of data sometimes makes tables suitable. For example, when
data does not vary much across categories of characteristics, or when they vary
too much, tables are a better choice of presentation than graphs.
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Annex tables contain much information and are often presented in the document annex.
List tables appear in the body of the document to compliment text.

Maps

Maps provide a visual representation of how gender statistics vary across different
regions, helping to identify geographic patterns and disparities in sex ratios, employment
rates, educational attainment, health outcomes, and other gender indicators. This
geographic context can be critical in understanding and addressing regional issues
related to gender.

The steps in generating maps include:
1. Select the Data:
e Gather relevant statistical data that is geographically referenced.
e Ensure the data is accurate, up-to-date, and suitable for mapping.
2. Choose the Type of Map:

e Decide on the most appropriate type of map for your data (e.g., choropleth
maps for density or concentration, dot distribution maps for occurrence
points, heat maps for intensity, etc.).

3. Prepare the Data:

e Clean and preprocess the data to ensure it is compatible with mapping
software.

e Aggregate or disaggregate the data as needed to match the geographical
units (e.g., countries, states, cities).

4. Select Mapping Software or Tools:

e Choose a mapping tool or software that fits your needs (e.g., GIS software
like ArcGIS, QGIS, or online tools like Google Maps, Tableau, or Mapbox).

5. Create the Map:
e Import the data into the mapping tool.

e Configure the map settings, such as projection, scale, and boundaries.
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e Apply the appropriate map chosen in step 3.

6. Design the Map:

e Choose suitable colours, symbols, and legend to represent the data clearly
and effectively.

e Ensure the map is visually appealing and easy to interpret.

e Add titles, labels, and annotations to provide context and enhance
understanding.
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7. Include Supporting Elements:

e Add alegend to explain the map's symbols and colours.
e Include a scale bar to indicate distances.

e Provide a north arrow for orientation.

e Add any relevant text or descriptions to provide further context.
Infographics

Infographics are visual representations of information, data, or knowledge intended to
present complex information quickly and clearly. They combine text, images, charts,
and diagrams to create a compelling and easily digestible narrative. Infographics often
use visual metaphors and icons to illustrate concepts and relationships, enhancing the
audience’s ability to understand and retain information. The steps involved in producing
an infographic include:

1. Outline Key Points: Decide on the main points and messages to communicate.
Organize these points in a logical flow.

2. Select the Infographic Type: Choose an appropriate format, such as:
a. Statistical Infographics: Focus on presenting raw numbers and comparisons.

b. Informational Infographics: Provide explanations and context along with
data.

c. Timeline Infographics: Show changes over time.
d. Comparative Infographics: Compare different groups or categories.

3. Select a Design Tool: Choose a design tool that suits your needs and skill level.
Popular tools include Adobe lllustrator, Canva’, Piktochart?, and Infogramé.

4. Templates and Customization: Use templates for a quick start but customize
them to fit your specific data and branding.

5. Design the Infographic

a. Choose a Colour Scheme: Select colours that enhance readability and
highlight key data points. Use colour coding to differentiate between
categories.

b. Create Visual Hierarchy: Use size, colour, and placement to emphasize the
most important information. Ensure the title and key messages stand out.

c. Incorporate Charts and Graphs: Use bar charts, pie charts, line graphs, or
other visual tools to present data clearly.

d. Add Icons and lllustrations: Use icons to represent different categories

1 http://www.canva.com
2 https://piktochart.com

8 https://infogram.com/
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or data points. lllustrations can make the infographic more engaging and
easier to understand.

e. Include Text Sparingly: Use concise text to explain data points and provide
context. Avoid overcrowding the infographic with too much text.

Exercise 5.1B: Qualities of a good infographic

9
g Look at the infographic below' and suggest:

e lIts good features.

e How it can be improved.

cesseness COSTS AUSEralia sessssess
SEXUAL
$2 I .Zch year I ’545 CIREEHCES

| 2015-16

H

In Australia,
have experienced physical violence

most o
common 9 5 °
{orims of viokince agalonsg
wamnn in Australia ani of @l victims of violenoe,
IMHTabe prar e violsnoe experience violence

"ml“": p::"l’:r from a male
have experienced PR PtCROr
s:exunl violence since the age of 15,

1 Source: Women's Health in the North (WHIN). https://www.whin.org.au/brc/about-building-a-respectful-comm unity/.
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g Answers to Exercise 5.1B: Qualities of a good infographic

It is good infographic because:

a. Itis built on a single colour scale + white, making it very easy for the eye to look
at the relevant information without distractions.

b. It uses a pictorial bar to represent “one in three women” and “one in five women”,
which makes the information easy to understand and engaging. The coloured
part of the bar is exactly proportional to the statistics it represents.

MODULE FIVE
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C.

b)

It uses typography to highlight the most shocking information, i.e. the cost of
violence against women in Australia: “21.7 billion”.

It can be improved in the following ways:

There is too much information for the reader to retain; some of the information
can be dropped to focus only on the “cost of violence in Australia”.

If the key message is the cost of violence, there needs to be a link with health
services or other forms of public services to support victims, or with victims
missing working days, etc. This is currently missing from the infographic.

The information about 95% men is supported with three male icons. It might be
better to include a visual which represents 95% accurately.

The size of different fonts (e.g. typography) appears in varying sizes on different
parts of the infographic, making it difficult for the reader to know where to focus
their attention.

EMBEDDING GENDER STATISTICS IN DECISION-MAKING
A Facilitator Guide for Training of Users of Gender Statistics in Uganda



REFERENCES

African Development Bank Group. (2019). Regional gender strategy for the East Africa region

2019-2023. Retrieved from https://www.afdb.org/fileadmin/uploads/afdb/Documents/
Publications/East_Africa_Regional_Gender_Strategy_2019-2023.pdf

African Union. (2020). Protocol to the African Charter on Human and Peoples’ Rights on

the Rights of Women in Africa. Retrieved from https://au.int/en/treaties/protocol-african-
charter-human-and-peoples-rights-rights-women-africa

Economic Commission for Africa (ECA). (2017). Gender and statistics in Africa. Addis
Ababa: Economic Commission for Africa. Retrieved from https://repository.uneca.org/
handle/10855/23298

Hedman, Birgitta, Francesca Perucci and Pehr Sundstrom (1996). Engendering Statistics: A
Tool for Change. Stockholm: Statistics Sweden.

International Labour Organization (ILO). (2018). World employment and social outlook:
Trends for women 2018 — Global snapshot. Geneva: ILO. Retrieved from https://www.ilo.

org/global/research/global-reports/weso/trends-for-women-2018/WCMS_619577/lang--
en/index.htm

Valcheva Silvia (n.d.): Types of Data. Retrieved June 19, 2024, from Types of Data -
Infographic | Data science learning, Data science, Data scientist (pinterest.com)

Roddewig Stephen (2012): What is the difference between data and information? Retrieved
July 10, 2024, from https://blog.hubspot.com/marketing/difference-between-data-and-

information

OECD. (2019). Gender and the economy. Paris: OECD Publishing. Retrieved from https://
www.oecd.org/social/gender-and-the-economy/

Uganda Bureau of Statistics (UBOS). (2020). Gender statistics profile. Kampala: UBOS.

Retrieved from https://www.ubos.org/wp-content/uploads/publications/03_2021Gender
Statistics_Profile_March_2021.pdf

United Nations Children’s Fund (UNICEF). (2017). The State of the World’s Children 2017:
Children in a digital world. New York: UNICEF. Retrieved from https://www.unicef.org/

reports/state-worlds-children-2017

United Nations Development Programme (UNDP). (2016). Gender equality strategy 2016-

2020. New York: UNDP. Retrieved from https://www.undp.org/publications/gender-
equality-strategy-2016-2020

United Nations Economic and Social Commission for Asia and the Pacific (UNESCAP).
(2018). Gender statistics manual. Bangkok: UNESCAP. Retrieved from https://www.
n .org/r r nder-statistics-manual

Open Data Watch (n.d.) The Data Value Chain: Moving from Production to Impact. Retrieved

EMBEDDING GENDER STATISTICS IN DECISION-MAKING 105
A Facilitator Guide for Training of Users of Gender Statistics in Uganda

(72)
L
O
<
L
oc
LU
LL
L
(a's




July 10, 2024, from The Data Value Chain: Moving from Production to Impact — Open Data
Watch

United Nations Entity for Gender Equality and the Empowerment of Women (UN Women).
(2021). Gender mainstreaming and women’s empowerment in national budgets. Retrieved

from https://www.unwomen.org/en/digital-library/publications/2021/04/gender-
mainstreaming-and-womens-empowerment-in-national-budgets

United Nations Statistics Division (UNSD). (2016). Integrating a gender perspective
into statistics. New York: United Nations. Retrieved from https://unstats.un.org/unsd/

demographic-social/Standards-and-Methods/files/Handbooks/gender/Integrating-a-
Gender-Perspective-into-Statistics-E.pdf

United Nations, Economic Commission for Europe, and World Bank Institute (2010).
Developing gender statistics: a practical tool. Geneva. ECE/CES/8.

United Nations. (2015). Transforming our world: The 2030 Agenda for Sustainable Development.
New York: United Nations. Retrieved from https://sdgs.un.org/2030agenda

World Bank. (2019). Women, business and the law 2019: A decade of reform. Washington,

DC: World Bank Group. Retrieved from https://openknowledge.worldbank.org/
handle/10986/31327

World Health Organization (WHO). (2018). Gender, health and work: A review. Geneva:
WHO. Retrieved from https://www.who.int/publications/i/item/gender-health-and-work-
a-review

Uganda 3 National Voluntary Review Report on implementation of SDGs 2024 - https://
africa.unwomen.org/en/digital-library/publications/2024/07/ugandas-3rd-voluntary-
national-review-report-on-the-implementation-of-the-2030-agenda-for-sustainable-
development

106 EMBEDDING GENDER STATISTICS IN DECISION-MAKING
A Facilitator Guide for Training of Users of Gender Statistics in Uganda



ANNEXES

Appendix I: Pre-Training Registration/ Needs Assessment Form

Dear prospective participant,

EPRC/UBOS/MGLSD (delete as appropriate) has organised a training workshop aimed at
improving the technical capacity of selected government/ civil society officers (delete as
appropriate) to access and utilise gender statistics towards the achievement of gender
equality and women’s empowerment. To enable us to meet your training needs, we request
you to complete this Form. While the answers may be used during the training, no one will

know t
Part 1

1.

he answers provided by any of the participants.

Personal information

Title

Dr/Mr./Mrs./Ms.

Name

Job Title

Organ

MDA/LG/

isation

Sex (Male/ Female)

Email

Telephone Number

Part 2
2.

3.
4.

What gender statistics does your agency need to fulfill its mandate in promoting
gender equality and empowering women?

In what ways does your agency use gender statistics?

What sources of information does your agency currently use to obtain gender
statistics? Please mention specific sources

How effective are the above sources in meeting the gender statistics information
needs of your agency?

a) Very effective

b) Effective

c) Somewhat effective
d) Not effective

e) Not at all effective
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6. What specific gaps do you perceive in the current gender statistics available to
your agency?

7. Haveyou ever attended an in-person or online training in producing or using gender
statistics?

a) No.
b) Yes.

8. If yes, what specific topics related to gender data or statistics production, or use
were covered in the training events above? You may tick more than one topic.

a) Key concepts and terminology in gender statistics

b) Gender in data collection

c) Gender in data analysis, presentation, report writing, and visualization
d) Communicating or disseminating gender statistics

e) Utilising gender statistics in decision-making (policy-making, programming,
advocacy, etc.)

f) Gender statistics in specific sectors or studies (e.g. health, education,
agriculture, demographic & health surveys, census, etc.)

g) Other, specify.

9. How confident do you feel in your understanding of gender statistics concepts and
methodology?

a) Very confident.

b) Confident

c) Somewhat confident
d) Not confident

e) Not confident at all.

10. Please rate your current level of understanding of these topics (Please tick)

Topic Limited | Good | Very
good

Key concepts and terminology in gender statistics

Gender in data collection

Gender in data analysis, presentation, report writ-
ing, and visualization

Communicating or disseminating gender statistics

Utilising gender statistics in decision-making (poli-
cymaking, programming, advocacy, etc.)
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Gender statistics in specific sectors or studies
(e.g. health, education, agriculture, demographic &
health surveys, census, etc.)

11. Which of the following specific topics related to gender statistics would you want

to learn more about? Tick not more than three preferred topics.

a) Key concepts and terminology in gender statistics

b) Gender statistics in data collection

c) Gender statisticsin data analysis, presentation, report writing, and visualization
d) Communicating or disseminating gender statistics

e) Utilising gender statistics in decision-making (policy making, programming,
advocacy, etc.)

f) Collecting and using gender statistics in specific sectors or studies

12. Which facilitation methods and additional considerations would enhance the

overall effectiveness of the planned gender statistics training??

Appendix II: Training Workshop Evaluation Form

Please help us to improve the quality of the training we provide by taking a few moments to
complete this Form. You must not state your name, but if you do it will help us if we want to
follow up any of your suggestions. Please use another sheet of paper if you need more space
for your responses.

D)

2)

How well did the content match the learning objectives of this training workshop?

Not at all 1 2 3 4 5 Very Well

Comments

How appropriate was the choice of methods used to achieve those learning
objectives?

Not Appropriate 1 2 3 4 5 Appropriate

Comments
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3)

4)

5)

7)

8)

How would you rate the facilitator(s) of this workshop?

Poor 1 2 3 4 5 Very Good

Comments

How much additional knowledge do you feel you have gained from this training?

Very Little 1 2 3 4 5 Very Much

Comments

How much has this learning opportunity increased your confidence in now being
able to access and utilize gender statistics in your work?

Very Little 1 2 3 4 5 Very Much

Comments

6) Which topics/sessions did you find most useful? If possible, please identify why.

Comments

Which topics/sessions did you find least useful? If possible, please identify why
and what could have been done differently to make the learning more useful/
relevant for you.

Comments

How do you plan to apply the knowledge and skills acquired during this training in
your work?

Comments
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9) Any other comments you would like to make regarding aspects not covered in the
above:

Comments

Please hand in this Form before leaving

THANK YOU FOR YOUR HONEST FEEDBACK!

Appendix lll: Sample Training Report Template

1. Cover page
e Title of Training
e Name of Training Organiser
e Date(s) (both the dates when the training took place and the date of the report)
e Location (town, country) of the workshop
e Report Author
e Logos of partners/organizers
1. Table of Contents
2. Executive Summary (for big reports, as per the organisation’s House style)
3. Background to the workshop:
e Background and context
e Targeted audience
3. Participants and facilitators
e Participants: Number and categories, including by sex)
« Details of facilitators (names and affiliations)
4. Training Objectives
5. Discussions and training activities:
e Include details of the contents (topics)

e Training methods and materials used (e.g., presentations, workshops, hands-
on activities)
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6. Training evaluation and feedback
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7. Recommendations (based on participants’ evaluation and feedback and facilitators
experiences)

e Areas for improvement/ suggestions for future training programmes

e Follow up action plan to enhance the application of knowledge by trainees.
8. Acknowledgements of collaborators and donors
9. Appendixes attached to the report should include:

a) List of participants, including their designation, address, phone number, and
email, along with all staff involved in planning and coordinating the training

b) Workshop programme/agenda
c) Copies of training materials (slides, handouts)
d) Detailed feedback/evaluation results from participants

e) Additional resources or references
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